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Safety Instructions

Safety Instructions • English

 WARNING:  This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within the 
product’s enclosure that may present a risk of electric shock.

ATTENTION:	  This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

   
 

  

 
 

 

Sicherheitsanweisungen • Deutsch

WARUNG:	 Dieses Symbol  auf demProdukt soll den Benutzer darauf 
aufmerksam machen, dass im Inneren des Gehäuses dieses Produktes 
gefährliche Spannungen herrschen, die nicht isoliert sind und die einen 
elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in der im 
Lieferumfang enthaltenen Dokumentation besonders wichtige Hinweise 
zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in den 
Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, avisa al 
usuario de la presencia de voltaje peligroso sin aislar dentro del producto, 
lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:		 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento estas estan incluidas en la documentación proporcionada 
con el equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT :	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du produit 
d’une tension électrique dangereuse susceptible de provoquer un choc 
électrique.

ATTENTION :	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, signale 
à l’utilisateur des instructions d’utilisation ou de maintenance importantes 
qui se trouvent dans la documentation fournie avec l’équipement.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68‑290-01, sur le site 
Extron, www.extron.com.

Istruzioni di sicurezza • Italiano 

AVVERTENZA:	 Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di tensione non isolata pericolosa all’interno del 
contenitore del prodotto che può costituire un rischio di scosse elettriche.

ATTENTZIONE:	 Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di importanti istruzioni di funzionamento e 
manutenzione nella documentazione fornita con l’apparecchio.

Per informazioni su parametri di sicurezza, conformità alle normative, 
compatibilità EMI/EMF, accessibilità e argomenti simili, fare riferimento alla Guida 
alla conformità normativa e di sicurezza di Extron, cod. articolo 68‑290‑01, sul 
sito web di Extron, www.extron.com.

Instrukcje bezpieczeństwa • Polska 

OSTRZEŻENIE:	 Ten symbol, , gdy używany na produkt, ma na celu 
poinformować użytkownika o obecności izolowanego i niebezpiecznego 
napięcia wewnątrz obudowy produktu, który może stanowić zagrożenie 
porażenia prądem elektrycznym.

UWAGI:	 Ten symbol, , gdy używany na produkt, jest przeznaczony do 
ostrzegania użytkownika ważne operacyjne oraz instrukcje konserwacji 
(obsługi) w literaturze, wyposażone w sprzęt.

Informacji na temat wytycznych w sprawie bezpieczeństwa, regulacji wzajemnej 
zgodności, zgodność EMI/EMF, dostępności i Tematy pokrewne, zobacz Extron 
bezpieczeństwa i regulacyjnego zgodności przewodnik, część numer 68-290-01, 
na stronie internetowej Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению электрическим 
током.

ВНИМАНИЕ: 	 Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций по 
эксплуатации и обслуживанию в руководстве, прилагаемом к 
данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других вопросах 
см. руководство по безопасности и соблюдению нормативных 
требований Extron на сайте Extron: , www.extron.com,  
номер по каталогу - 68-290-01.

https://www.extron.com
https://www.extron.com
https://www.extron.com
https://www.extron.com
https://www.extron.com
https://www.extron.com
https://www.extron.com
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안전 지침 • 한국어 

경고: 	 이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:	 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 대한 
자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 규제 준수 
안내서, 68-290-01 조항을 참조하십시오. 

安全说明 • 简体中文 

警告： 产品上的这个标志意在警告用户, 该产品机壳内有暴露的危险
电压，有触电危险。

注意： 产品上的这个标志意在提示用户, 设备随附的用户手册中有重
要的操作和维护(维修)说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍使 
用的特性等相关内容， 
敬请访问 Extron 网站 , www.extron.com，参见 Extron 安全规范指南，产品编号 
68-290-01。

安全記事 • 繁體中文 

警告:  若產品上使用此符號，是為了提醒使用者，產品機殼內存在未隔離的危險

電壓，可能會導致觸電之風險。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有重要

的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資訊，

請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規遵守手

冊》，準則編號 68-290-01。
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Conventions Used in this Guide

Notifications
The following notifications are used:

ATTENTION:	

•	 Risk of property damage. 

•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” represents the 
capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:

ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Extron Glossary of Terms
A glossary of terms is available at http://www.extron.com/technology/glossary.aspx.

http://www.extron.com/technology/glossary.aspx
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Introduction

•	 About this Guide

•	 About the Room Scheduling System

•	 Application Diagram

•	 Features

About this Guide
This guide provides information about the hardware and software required to install, 
configure, and operate the Extron Room Scheduling System.

The topics include:

•	 TouchLink Scheduling panels (TLS)

•	 Wayfinding panels (TLSI)

•	 Room Agent Software

About the Room Scheduling System
The Extron Room Agent system consists of the software (Room Agent) and the hardware on 
which it runs (TLS and TLSI panels). A list of Compatible Panels is on the following page.

When the system is running, conference rooms are booked in advance through any of the 
available calendar systems. A list of available Calendar Servers is on the following page.

The touchpanel outside the conference room displays the schedule for that conference 
room for the next three hours. If the conference room is not booked at any point during the 
next three hours, users can schedule a “walk-up” ad hoc meeting during the free time.

The Room Agent configuration program is available for download from the Extron website 
(see Downloading Software on page 15 for more information). The program allows a 
system administrator to integrate and configure all the touchpanels in the system, which 
can vary in size from one to thousands of panels. The system configurations can be saved 
and the individual configuration file for each touchpanel can be saved on that touchpanel. If 
required, the configuration files from all the individual touchpanels can be pulled back to the 
control PC to rebuild the system configuration file.

Wayfinding devices collate information from all the TLS panels in the system. This allows 
room availability to be viewed and rooms to be booked from a single centralized location. It 
is ideal for use in high traffic areas, including building lobbies, meeting room hallways, and 
corridors.
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Calendar Servers
The Room Agent software interfaces with the following calendar servers to provide 
scheduling capabilities for all the conference rooms in the system.

•	 Ad Astra

•	 CollegeNET 25Live®

•	 EMS Software™

•	 Google™ Calendar™

•	 Microsoft® Exchange™

•	 Microsoft Office 365™

•	 Rendezvous by NFS (NFS)

Compatible Panels
As of June 2021, Extron recommends the following TLS panels for use with the 
Room Agent software. These models ship with the latest firmware for the scheduling 
system. No firmware update is required.

Check with www.extron.com to see a list of the latest recommended TLS panels.

•	 TLS 525M — A 5‑inch (measured diagonally), wall‑mounted panel with an 800x480 
capacitive glass touchscreen. See the TLP Pro 525, 725, and 1025 Series User Guide 
for complete information about the product, including mounting options.

•	 TLS 725M — A 7‑inch, wall‑mounted panel with an 1024x600 capacitive glass 
touchscreen. See the TLP Pro 525, 725, and 1025 Series User Guide for complete 
information about the product, including mounting options.

•	 TLS 1025M — A 7‑inch (measured diagonally), wall‑mounted panel with a 1280x800 
capacitive touchscreen. See the TLP Pro 525, 725, and 1025 Series User Guide for 
complete information about the product, including mounting options.

•	 TLSI 201 — An Interactive Wayfinding Interface that collates information from all the 
TLS panels in the system. This information is displayed on a large third-party display 
screen, which allows room availability to be viewed and rooms to be booked from a 
single centralized location. The interface supports resolutions up to 4K. See the TLSI 
201 User Guide for complete information about the product.

The following panels are retired but still supported by the Room Agent software.

•	 TLS 520M •	 TLP Pro 720M •	 TLS 1022T

•	 TLP Pro 520M •	 TLP Pro 720T •	 TLS 1022M

For information about mounting and basic setup for these panels see Hardware on 
page 133. More detailed information is available in the User Guide for the corresponding 
touchpanel.

Unlike other applications that use Extron touchpanels, there are no controllers to be 
configured.

The panels do not require complicated setup or programming. Users can book a room from 
any device connected to the room calendar, including their mobile devices, a connected 
panel, or a Wayfinding device.

All panels can receive power and communication over a single Ethernet cable. Power over 
Ethernet (PoE) eliminates the need for a local power supply. PoE requires a PoE injector, 
which is sold separately.

https://www.extron.com
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Room Agent software, installed on a computer with network access, allows system 
administrators to set up the Extron TouchLink Scheduling panels as room scheduling 
appliances by filling in the required fields that correspond with areas of the user interface. 
Customization options allow a variety of fields to be shown or hidden, depending on user 
preference.

Booking a room from the panel is as easy as tapping the Reserve button on the panel. The 
intuitive interface also provides at-a-glance room availability and a timeline view of the status 
of the room for half a day ( 1). In addition to the customizable panel interface, bright LEDs 
within the bezel provide at-a-glance room availability status from a distance.

11am 12pm 1pm11:30 12:30 1:30

Main Conference Room

Reserve

January 10, 10:33am

10:30

Available

Figure 1.	 Typical Room Display on a TLS 725M Scheduling Panel

System Benefits
The Room Scheduling System can be integrated into any network and requires minimal 
network bandwidth for communication between each panel and the room calendar server. 
Benefits of being room calendar server clients, communicating directly with the room 
calendar server, include:

•	 Ensures the security of information — Each panel maintains a separate connection 
to a dedicated resource calendar that is assigned to the room associated with the 
panel through 25Live, EMS, Google Calendar, Microsoft Exchange, Office 365, and 
Rendezvous by NFS. Each resource calendar has a unique username and password 
that the panel uses to connect to the server. Administrators can manage the information 
of each room scheduling panel using tools, accounts, and privileges provided by their 
scheduling calendar console.

•	 Simplifies system management — This direct communication simplifies user access 
management for the administrator, and does not require any middleware or additional 
products to be placed on the network.

•	 Eliminates a single point of failure — The Room Scheduling System requires 
no middleware or intermediate server between the panels and the calendar server, 
eliminating the possibility of a single point of failure.
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Security Overview
•	 All communications between the Room Agent software and the panels, between the 

Wayfinding devices and the TLS panels, and between the panels and the calendar room 
server are encrypted.

•	 When you are using the Room Agent Software to configure the panels, all 
communications between the software and the touchpanels are encrypted.

•	 Each conference room is assigned a unique room mailbox. This mailbox is restricted so 
that it cannot be used for interactive log-ons (the ability to send or receive e-mail).

•	 As part of the Room Agent software configuration process, the administrator enters 
the authentication information for each room. These values are sent as part of the 
configuration file to the panel. No other user ids or passwords are used.

•	 The software encrypts the account data. If a password is displayed on the user 
interface it is obscured, and any sensitive information is encrypted when stored on the 
administrator PC.

•	 Administrators can choose to save the panel configurations, including the account 
credentials, on their PCs in a password-protected file.

NOTE:	 The protected configuration files include the authentication data for each 
account. Use discretion when allowing access to these files.

•	 All panels are password protected. The factory configured passwords for all accounts 
on this device have been set to the device serial number. Passwords are case sensitive.	

NOTE:	 If the device is reset to default settings, the password is the default 
password configuration. The default password is extron (for either admin or 
user).

•	 During configuration, there is an opportunity to change the password and Extron 
strongly recommends that you do.

Network Traffic
The traffic generated on the network consists of requests for data and responses from the 
room calendar server. Communications occur at regular intervals, such as when requesting 
meetings, sending meeting invitations, or when administrators retrieve an activity file for a 
room from the panel. Panel configuration, typically completed once during the initial setup 
of the system, also produces traffic on the network. The panel provides options to create 
an ad hoc meeting, extend a meeting, end a meeting, and confirm a meeting using the 
Check-In button, provided that these options were made available to the user when the 
administrator configured the panel.
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Application Diagram
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Figure 2.	 Typical Extron Room Scheduling System Application
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Features

Room Agent
•	 Make on-demand reservations from the touchpanel, computer, or any smartphone or 

tablet that connects to Microsoft® Exchange and 365®, Google Calendar™, 25Live®, 
EMS, NFS, and Ad Astra®.

•	 Provides easy integration with Microsoft Exchange 2007, 2010, 2013, 2016, 2019, and 
365 for convenient scheduling right from Outlook.

•	 Supports TLSI 201 Interactive Wayfinding Interface to provide real-time meeting space 
availability, status, and location information using a centralized display.

•	 Ability to view meeting attendees for panels configured with Microsoft 365, Exchange, 
and Google.

•	 Ability to set or view room capacity via TLS panel — Users can now set/view the 
room capacity via the TLS panel user interface.

•	 PIN access for TLS panels configured with Microsoft 365, Exchange, Google, and 
25Live, enabling users to reserve, book, check-in and extend a meeting via a PIN 
(English Only).

•	 Supports 27 languages — Multi-language support now allows TLS panel and TLSI 
Interactive Wayfinding users the option to:

•	 Display up to 2 languages simultaneously (for example display both English and 
Canadian French translations on the TLS panel user interface).

•	 Display multiple languages, one at a time.

•	 Room Agent software fully translated into Simplified Chinese.

(For a list of supported languages, see Supported Languages on page 149.)

•	 Ability to download a room Activity File without using Room Agent — Users can 
now retrieve the activity file without the need of Room Agent by connecting to the TLS 
using an SFTP client.

•	 Room usage data provides insight into trends and activity — Each touchpanel 
includes a downloadable Scheduling Activity file that enables you to generate analytics 
on usage, activity patterns, and trends using data from across the enterprise or 
organization.

•	 Supports two factor authentication (OAuth) required for Microsoft 365.

•	 Ability to search domains via communication settings for TLS and TLSI devices 
— Users can now search for a specific domain in Room Agent software.

•	 All panel updates are conveniently handled through Room Agent. Ability to push 
firmware to a single panel or multiple panels, simultaneously. Deploy a single 
touchpanel, or multiple touchpanels with similar settings very easily. 

•	 Provides service account and impersonation support — Touchpanels can 
be configured using a service account with Microsoft Exchange or 365, simplifying 
administrative tasks.

•	 Support for 802.1X certification on TLS panels, which can be managed via Extron 
Toolbelt software.

•	 Make meeting rooms available as soon as a scheduled meeting ends.

•	 Microsoft Exchange and 365 auto-discovery streamlines system setup.
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TLS
•	 TLS panels have capacitive edge-to-edge glass touchscreen and come in three sizes:

•	 5" touchscreen with 800x480 resolution.

•	 7" touchscreen with 1024x600 resolution.

•	 10" touchscreen with 1280x800 resolution.

•	 Gorilla Glass® screen is tough, scratch, and smudge-resistant — Corning Gorilla 
Glass is stronger and more scratch-resistant than standard glass, while maintaining 
touch sensitivity, color saturation, and brightness.

•	 Ability to set or view room capacity via TLS panel — Users can now view the next 
upcoming meeting via the TLS panel user interface.

•	 All communication between the touchpanel and calendar server is encrypted and 
secure.

•	 Digital input allows connection to an occupancy sensor, such as the Extron OCS 100.

•	 Check-In Button confirms attendance for the scheduled meeting and retains the 
reserved status of the room, even if the start of the meeting is delayed.

•	 Two color themes, custom loaded background images, and transparency controls 
provide personalized branding options

•	 Customizable date and time formats with a preview showing how the UI will look on the 
touchpanel.

•	 Customizable room availability hours — Allows one to select the start and end 
times for the availability of a room.

•	 View details of the meetings scheduled for the day.

•	 View/edit network adaptor information in Room Agent — Users can now view 
network adaptor information via the Manage tab in Room Agent software.

•	 No annual subscription or maintenance fees.

•	 Meetings scheduled as private will by default have the meeting details hidden for 
meetings scheduled with Microsoft Exchange, 365, and Google Calendar.

•	 Display up to 50 characters from the meeting body details for panels 
configured with Microsoft Exchange and 365 — The TLS can display up to 50 
characters from the meeting body for any selected custom dropdown.

•	 Meeting Subject Line accommodates up to 2 lines of text.

•	 Two bright LED lights make it easy to see if a room is occupied or available even from 
down the hall.

•	 Rear-facing light bars reflect off the mounting surface providing enhanced visibility of 
room status (TLS 725 and 1025 only).

•	 Power over Ethernet — PoE allows the TLS panel to receive power and 
communication over a single Ethernet cable, eliminating the need for a local power 
supply.

•	 Can be mounted in a one-gang (TLS 525M) or two-gang (TLS 725M and 1025M) 
junction box, or on a wall, lectern, or any flat surface, including glass.

•	 (TLS 525M only) Supports the optional RWM 1 Recessed Wall Mount and SMK 1 
Surface Mount Kit.

•	 (TLS 725M only) Supports the optional RWM 2 Recessed Wall Mount and SMK 2 
Surface Mount Kit.



Room Scheduling System • Introduction 8

 

TLSI
•	 Find and book a meeting space for current day or week from a centralized location.

•	 Easily navigate real-time information on a landscape or portrait display using a dual view 
list layout and customer-provided map.

•	 Connects directly with TouchLink scheduling panels.

•	 Configurable with free Room Agent software.

•	 Ideal for use with third-party screens 40 inches or larger and up to 4K resolution.

•	 Set screen transition times — Users of the Wayfinding Interface can specify screen 
transition durations via Room Agent.

•	 Ability to view meeting attendees via Wayfinding (TLSI) device for rooms configured with 
Microsoft 365, Exchange, and Google.

•	 Ability to view room capacity via Wayfinding (TLSI) device.

•	 Requires no additional programming or external processors.

•	 PoE+ compatible — Product is powered directly by a PoE+ switch or injector, 
eliminating the need for bulky local power supplies.

•	 One high speed USB 2.0 port for third-party touchscreens or HID support.

•	 Simple customization options including logo, personalized message, and color themes.

•	 Flexible meeting information fields can be turned on or off as needed.

•	 Compact 1" high, half rack width low profile metal enclosure allows discreet installation 
behind a flat panel display.
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Software Overview

This section provides an overview of how to use the Room Agent software and describes 
how to download software and firmware.

•	 Using the Room Agent Software (Overview)

•	 Downloading Software

•	 Updating Firmware

Using the Room Agent Software (Overview)

Before You Start
TLS and TLSI devices should be mounted and connected to the network.

Obtain the following network information for all your devices:

•	 DHCP status — (on or off). If DHCP is off, you must also obtain:
•	 IP address •	 Subnet mask •	 Gateway

•	 User name — This can be either admin or user.

•	 Password  — The factory configured passwords for all accounts on this device have 
been set to the device serial number. Passwords can be changed during configuration. 
Passwords are case sensitive.

NOTE:	 If the device is reset to default settings, the password is the default 
password configuration. The default password is extron (for both admin or 
user).

•	 Make a note of the Touchpanel MAC address, which can be found on a rear-panel label.

•	 Download and install Room Agent and Toolbelt on the control PC (see Downloading 
Software on page 15).

SSL security certificates and IEEE 802.1X authentication — TLS panels come with a 
factory-installed Secure Sockets Layer (SSL) security certificate. IEEE 802.1X authentication 
is also supported once enabled. See Secure Sockets Layer (SSL) Certificates on 
page 153 or see IEEE 802.1X Certificates on page 154 for more information. 

Minimum system requirements

To configure the system, you must download the Room Agent software onto a PC that has 
the following minimum requirements: 

•	 CPU — Intel® Core 2 Duo or equivalent processor

•	 Operating System — Windows® 7, Windows 8.1, or Windows 10

•	 Memory — 4 GB of RAM

•	 Hard disk space — 500 MB of available hard disk space

•	 Display Resolution — 1280 x 768 minimum

•	 Network connection — A data transfer rate of 10 Mbps. Recommended: 100 Mbps.

•	 Microsoft .NET Framework 4.5.1
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Using Room Agent

Application Licensing

When Room Agent is started, or after log-out from a previous session, the Application 
Licensing dialog box opens.

Figure 3.	 Log in to Room Agent

To attain full functionality, enter your Extron Insider login and password in the appropriate 
fields. When verified, the application can be run with full functionality.

Figure 4.	 Check in to Room Agent

When a user is logged in, the Licensing Details shown are:

•	 User Name (blurred out in figure 4)

•	 Date of last check-in

Click Check In to renew the license.

Click Close to close the dialog and start working with Room Agent.
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Alternatively, if you are not online, and are unable to link directly to a network, click on the 
Offline tab.

Figure 5.	 Application Licensing Offline

An auto generated request key is given. Follow the instructions given in the dialog box to 
obtain a response key to activate to full functionality.

Click Close to close the window and begin using Room Agent.

The user can log out from the session, which removes the saved credentials (Username and 
Password). If a user logs out a confirmation dialog box opens.

To log out and exit the application, click Log Out in the Confirm Log Out dialog box.

Click Cancel to keep the session open.
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Discovering devices

1.	 Open Room Agent. By default, the program opens with the Manage tab selected. 
If required, select the Manage tab. For complete information, see Manage Tab on 
page 21.

Figure 6.	 Manage Tab

2.	 Click Discover. The button text changes to Stop Discovery (1).

A list of devices that are available on the same subnet as the PC is shown.

NOTES:

•	 After clicking Discover, the discovery process continues until you click Stop 
Discovery.

•	 The discovery process find all devices on the subnet that could be used by 
Room Agent, even if they have another function.

3.	 If required, click Network Adapter to search a different sub-network.

Any new devices that have been discovered are added to the list.

4.	 Step 4 can be repeated with additional sub-networks as required.

5.	 Click Authenticate for one of the devices (3).

6.	 Enter the password for that device. Once the device has been authenticated, the 
Authenticate button is replaced by an Actions menu and the Enter Password 
status  (2) is replaced by the message Ready.

7.	 Repeat steps 5 and 6 to authenticate all required devices.

figure 6
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Device configuration

1.	 Once all the touchpanels are set up, click Configure to open the Configure tab.

Figure 7.	 Configure Tab (TouchLink Panels)

2.	 Select TouchLink Panels or Wayfinding Device (1). Figure 7 shows TouchLink 
Panels selected.

3.	 Select the Status checkbox for one or more TLS panels.

4.	 Select a Calendar Type (2).

The column headings (3) change, depending on the calendar type selected. Figure 7 
shows the NFS calendar selected.

5.	 Assign a location to the TLS panel. This allows the touchpanel to be linked to a 
wayfinding device.

6.	 If required, repeat steps 4 and 5 to select a new group of panels and associate them 
with a different calendar server.

7.	 Select the Wayfinding Devices button in the top left corner of the screen.

Figure 8.	 Configure Tab (Wayfinding Devices)

For detailed instructions about configuring touchpanels and wayfinding devices, and 
saving the configurations, see Configure Tab on page 35.
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Designing the interface

Click Design.

Figure 9.	 Design Tab

The Design tab is used to determine how information is presented on the TLS panels and 
on the Wayfinding devices. Figure 9 shows the Design tab for the TLS panels.

The information shown on Wayfinding devices can be presented as a list or as a map. 
Choose the template that meets your need from the menu on the left side of the screen.

After modifying the design, you can overwrite an existing template or save the template with 
a new name.

For more detailed instructions about using the Design tab, see Design Tab on page 98.
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Downloading Software
The Extron Room Scheduling System requires you to install both the Room Agent software 
and Toolbelt software on a control PC.

This software must be downloaded from the Extron website (www.extron.com). You need 
an Extron Insider account to download either program. If you need to set up an account, 
contact your Extron sales representative.

To download Room Agent or Toolbelt, follow these instructions:

1.	 Open the Extron website in your browser.

2.	 Click the Download tab in the top menu bar (1).

Figure 10.	 Download from the Extron Page

3.	 Click Software (2).

Figure 11.	 Download Software

https://www.extron.com
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4.	 Use the left and right scroll arrows (1) to find the software. If it is not shown at the top 
of the page, click the letter R in the alphabet menu (2) for Room Agent. 

All Extron Software products with names beginning with the letter R are listed below.

Alternatively, click the letter T for Toolbelt.

Figure 12.	 Find Room Agent for Download

5.	 Scroll down to Room Agent and click the Download link next to Room Agent (1).

Figure 13.	 Room Agent Download

6.	 Provide the information requested and follow the instructions on the screen.

7.	 Navigate to the folder where the downloaded file was stored and click the Install 
icon. The Install Wizard opens at the Welcome page.

Figure 14.	 Start Room Agent Download

8.	 Click Next.
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Figure 15.	 Accept license Agreement

9.	 Read the license agreement and print it (if desired).

10.	Select the I accept the terms of the license agreement button.

11.	Click Next. You are prompted to save the software in the default folder. The default 
folder for Room Agent is C:\Program Files (x86)\Extron\Extron Room Agent.

If you want to install the program at another location, click Browse and select a different 
destination folder.

12.	Click Next. 

Figure 16.	 Download in Progress

The program is downloaded and installed. A green bar on the Setup Status screen 
shows the progress of the installation.
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13.	When the installation is completed, the final screen appears. Leave the box checked to 
add a desktop shortcut.

Figure 17.	 Download Complete

14.	Click Finish. The program is now installed and ready for use.

Updating Firmware
Extron TLS and TLSI panels have the latest firmware version when they are shipped from 
the factory. Over time, as new features are added, newer versions of the Room Agent 
software become available. In order to run the newer software versions, you may need to 
update the firmware on your panels.

The latest version of the firmware is packaged with the new software. Copy the firmware file 
to a computer on the same network as the touchpanel.

By default, when you download Room Agent to your PC, the firmware can be found at:  
C:\ProgramData\Extron\TLPScheduler\firmware\.

NOTE:	 The TLSI 201 and the TLS panels use different firmware. Ensure you obtain the 
correct firmware for your product.

Use one of the following options to upload and install the firmware on a TLSI 201 or TLS 
panel:

•	 Toolbelt (see Toolbelt Help File)

•	 Room Agent Manage tab (see Install Firmware on page 33)

•	 TLSI 201 Web Page (see page 148).
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Menu Button

Click the Menu button in the top right corner of the screen to open a drop-down menu 
that allows you to create new configurations, open existing configurations, and save 
configurations.

Figure 18.	 Menu Button

It also provides access to the About screen. The following options are available:

Figure 19.	 Menu Button Options

NOTES:

•	 Each touchpanel has an individual configuration file that describes how that 
touchpanel is set up. The system configuration file contains the individual records 
for every touchpanel in the system.

•	 The individual records are uploaded to the corresponding touchpanel, where they 
are saved and used to configure the touchpanel. If the system configuration file is 
lost or corrupted, it can be regenerated by pulling the individual records from all the 
individual touchpanels in the system.

•	 New Configuration — Opens a new (unnamed) system configuration file (see Notes, 
above).

•	 Open Configuration — Allows you to open and modify an existing system 
configuration file (see Notes, above).

Navigate to the location where the configuration file was saved, then select a file. You 
are prompted to enter the password that you provided when you saved the file.

•	 Save Configuration — Saves changes to an existing system configuration file (see 
Notes, above).

Notes
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•	 Save As... — Saves changes to a new (unnamed) configuration or allows you to save 
a copy of an existing configuration file (see Notes on page 19).

When you click this option, you are prompted to enter and reenter a password to 
protect the configuration file.

Figure 20.	 Save Configuration

1.	 Enter and reenter a password and Extron recommends that you use a strong 
password to protect the configuration file.

2.	 Click OK. A Save As dialog box opens.

3.	 Name the file and navigate to the folder where the file is to be saved.

4.	 Click Save.

•	 Application Licensing — See Application Licensing on page 10.

•	 About — Opens a splash screen that provides basic information about the program.

Figure 21.	 About Room Agent

Click Details or Licenses for more information.

Click OK to close the screen.

•	 Re-enable Confirmation Dialogs — Re-enables all dialogs that had previously been 
disabled by the user.

•	 Quick Start — Opens the Extron Quick Start Guide to Room Agent Software (PDF).

•	 Help File — Opens the Extron Room Agent Help file.

•	 Exit — Closes the program. You are prompted to save changes to the system 
configuration file before you close the program.
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Manage Tab

•	 Discover Panels

•	 Add Panels Manually

•	 Remove Panels

•	 Manage Tab

•	 Actions Drop-down List

•	 Actions

Extron Room Agent opens to the Manage tab:

Figure 22.	 Room Agent Manage Tab

Discover Panels
Press Discover (1) to list all the devices (panels and Wayfinding Devices) that Room 
Agent is able to find automatically. Only panels that are on the same subnet as the control 
PC are auto discovered.

When the Discover process begins, the text on the button changes to Stop Discovery. 
The discover process may take several minutes. Even after all the available panels have 
been discovered, the process remains active until you click Stop Discovery.

NOTE:	 The discover process finds all touchpanels in the subnet that could be used by 
the Room Agent system, even if they have another function.

figure 22
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If the control PC has access to more than one subnetwork, click Network Adapter (see 
figure 22, 4, on page 21) to connect to other available subnetworks.

The Available Network Adapters dialog box opens:

Figure 23.	 Network Adapter

1.	 Click on one of the available networks and then click OK.

2.	 The dialog box closes. Click Discover in the Manage tab to find panels that are 
available on the new network.

Add Panels Manually
TLS panels that are not available on any of the subnets accessed by the network adapter 
must be added manually.

1.	 Click + Add (see figure 22, 2).

The Add Device dialog box opens.

Figure 24.	 Add Device Dialog Box

2.	 Enter the IP Address/Hostname and Password in the corresponding fields.
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NOTES:

•	 All panels are password protected. The factory configured passwords for 
all accounts on each device have been set to the device serial number. 
Passwords are case sensitive.

•	 Passwords can be changed during panel setup and Extron strongly 
recommends that you do this.

•	 If the device is reset to default settings, the password is reset to the default 
password configuration, which is extron (for either admin or user).

3.	 Click Add. The new TLS panel is added to the Panels list.

4.	 Repeat steps 1-3 to add more panels manually. If you have several touchpanels to 
enter, it is good practice to save the configuration periodically (see Menu Button on 
page 19).

Once the panels have been discovered or added manually, they are listed in the Manage tab.

NOTE:	 TLS panels and Wayfinding devices are all listed together.

Figure 25.	 Panels Listed in the Manage Tab

The Manage tab has the following features:

•	 Check Box •	 Panel Status

•	 Search Box •	 Device Type Filter

•	 Status Link •	 Remove Panels

Remove Panels
To delete an unwanted panel:

1.	 Click Stop Discovery.

2.	 Click the X at the end of the row for the touchpanel to be removed (see figure 25, 6. 
The touchpanel is deleted from the list.

Notes

figure 25
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Manage Tab

Check Box
The check boxes (see figure 25, 1, on page 23) allow you to select and configure one 
or more panels. When one or more panels are selected the "Manage Tab Menu Bar" (see 
below) appears at the top of the screen.

Panel Status
The Panel Status column (2) shows the current status of each panel. When the panel 
is first discovered, it shows Enter Password. While the password is being authenticated, 
it shows Authenticating. Once the password is authenticated, it shows Ready. Other 
messages can appear, depending on the status of the panel.

Search Box
The Search box (3) allows you to search the list for a single panel or for a group of panels 
that share a common characteristic. You can search by:

•	 Status

•	 Host Name

•	 IP address (any octet that is unique to the panel)

•	 Firmware version

Device Type Filter
The Device Type filter (4) allows you to select all the devices in either of these categories:

•	 Panels

•	 Wayfinding Devices

Manage Tab Menu Bar
Use the check boxes at the left of the screen (1) to select one or more panels.

When one or more panels are selected, a new menu bar appears at the top of the page:

Figure 26.	 Manage Tab Menu Bar

The menu bar allows you to:

•	 Setup •	 Reboot

•	 Edit Settings •	 Reset

•	 Install Firmware

These options are also available from the Actions Drop-down List (see page 26). 
However, the Actions drop-down list does not have the Setup option.

The Manage tab menu bar allows you to carry out these actions on multiple panels in a 
batch. The actions shown in the Actions drop-down list are carried out on only the single 
panel selected.
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Status Link
The Status link (see figure 25, 5, on page 23) shows the status of each panel and 
allows the user to carry out actions on the panel:

1.	 Initially all the panels show Authenticate.

2.	 Click Authenticate. 

The Authenticate to Device dialog opens:

Figure 27.	 Authenticate to Device Dialog

Enter the password and click Authenticate.

The dialog box closes and the panel status changes to Authenticating.

3.	 Once the password is authenticated, the panel status changes to Ready.

The status link changes to Actions.

Click Actions to see a list of actions that can be carried out on that device.
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Actions Drop-down List

Figure 28.	 Actions Drop-down Menu

The Actions drop-down list allows you to:

•	 Edit Settings •	 Reboot

•	 Install Firmware •	 Reset

The Actions drop-down list allows you to carry out the same functions as the Manage tab 
menu bar. However, these actions are carried out on a single panel instead of a batch.

The Actions drop-down list does not have the Setup option.

Actions

Edit Settings
To edit settings for one or more panels simultaneously, use the check boxes to select one or 
more panels and, in the top menu bar that appears, click Edit Settings (see figure 34 on 
page 29).

To edit settings for a single panel, click Actions in the line for that panel and, in the drop-
down list that appears, click Edit Settings (similar to figure 37 but shows the current IP 
address and MAC address).

The Edit Settings window opens, showing two tabs:

•	 General

•	 Network
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General

By default, the Edit Settings window opens with the GENERAL tab selected. The options 
available are different for TLS Panels and Wayfinding Devices.

TLS Panels

The GENERAL tab for TLS panels has four sections: Display, Audio, Date and Time, and 
Passwords. Click on any of the headings to expand that section.

Figure 29.	 General Settings (TLS Panels)

Display

By default, the Display section is already open when the GENERAL tab is selected.

Figure 30.	 Display Settings

Use the Brightness slider or multibox to set the screen brightness. This setting needs to 
be higher when the ambient light is brighter.

Sleep Mode is an energy saving feature. When no activity is detected near the touchpanel 
for a user-defined period of time, the screen goes dark. When activity is detected near the 
touchpanel, the screen is activated again. Set sleep mode by toggling the On or Off switch. 
If sleep mode is on, set how long the period of inactivity should be before the touchpanel 
enters sleep mode.

When all the changes have been made, click SAVE or CANCEL at the bottom of the page 
(see figure 31).

Audio

Figure 31.	 Audio Settings

Use the Audio Volume fader or the multibox to set the audio volume. This determines the 
volume of the audible feedback from the touchpanel (for example, from button clicks).

When all the changes have been made, click SAVE or CANCEL at the bottom of the page 
(see figure 29).

figure 29
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Date and Time

Figure 32.	 Date and Time Settings

Decide how to set the time on the panel. The options are:

•	 Synchronize with an NTP server — Select the NTP server radio button and enter 
the Server path. You can use an IP address or a Fully Qualified Domain Name (FQDN). 
When this option is selected, all other options (except Server Path) are grayed out and 
unavailable.

•	 Set the time manually — Select the Manual radio button. Server Path is grayed out 
and unavailable but all other options are now available.

•	 Select the Timezone from the drop-down list. By default, this is (UTC-08:00) 
Pacific Time.

•	 Click Sync to PC to sync the panel with the control PC or set the time and date 
manually.

When all the changes have been made, click SAVE or CANCEL at the bottom of the page 
(see figure 29 on page 27).

Passwords

Figure 33.	 Password Settings

This panel allows you to reset the passwords for the TLS panel. The panel can have an 
Admin Password and a User Password.

NOTES:

•	 You cannot set a User Password until an Admin Password has been set.

•	 The factory configured passwords for all accounts on this device have been set to 
the device serial number. Passwords are case sensitive.

•	 If the device is reset to default settings, the passwords are reset to the default 
password, which are extron (for either admin or user).

Enter the new password in the Admin Password text box. By default, the new password is 
masked. To see the new password, click the "eye" icon. 

Enter the new password again in the Confirm Admin Password text box.

The old password is displayed in the textbox underneath each text box.

Once the Admin password is saved, repeat the process to set the user password.

When all the changes have been made, click SAVE or CANCEL at the bottom of the page 
(see figure 29 on the previous page).



Room Scheduling System • Manage Tab 29

 

If you select multiple devices by clicking two or more check boxes (see figure 25, 1, on 
page 23), you can configure all of the selected devices as a batch.

Figure 34.	 General Settings for Multiple Devices

The Display, Audio, Date and Time, and Passwords settings that are configured with the 
GENERAL tab are applied to all the selected devices.

You can also configure the network settings for multiple devices in a batch.

Figure 35.	 Network Settings for Multiple Devices

The Subnet Mask, Gateway address, and DNS Address that you set are applied to all 
devices.

The IP Address that you set is applied to the first device in the list of selected devices. The 
first IP Address is incremented by one and applied to the second device and so forth. For 
example, if the first IP address is set to 192.168.254.200, the second device is assigned 
the IP address 192.168.254.201, and the third device is assigned 192.168.254.202.

If an address is already assigned to another device, that address is skipped and the 
next available address is used. For example, in the example above, if the address 
192.168.254.202 was not available, the third device is assigned 192.168.254.203.

figure 34
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Wayfinding Devices

The GENERAL tab for Wayfinding devices (see figure 36) is different from the TLS panels.

Figure 36.	 General Settings (Wayfinding Devices)

There are no controls to set audio.

Display

Figure 37.	 Display Settings (Wayfinding Devices)

Room Agent provides a default driver for use with the display device connected to the 
Wayfinding device. You can replace it with your own driver:

1.	 Upload the driver to the control PC.

2.	 Click BROWSE (see figure 37, 1) and navigate to the folder where the driver was stored.

3.	 Upload the driver to the TLSI.

You can also select the resolution and frequency for the connected display (2).

When all the changes have been made, click SAVE or CANCEL at the bottom of the page 
(see figure 36, above).

figure 36
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Date and Time

The Date and Time settings for the TLSI panel are the same as those for the TLS panels.

Figure 38.	 Date and Time Settings

Decide how to set the time on the panel. The options are:

•	 Synchronize with an NTP server — Select the NTP server radio button and enter 
the Server path. You can use an IP address or a Fully Qualified Domain Name (FQDN). 
When this option is selected, all other options (except Server Path) are grayed out and 
unavailable.

•	 Set the time manually — Select the Manual radio button. Server Path is grayed out 
and unavailable but all other options are now available.

•	 Select the Timezone from the drop-down list. By default, this is (UTC-08:00) 
Pacific Time.

•	 Click Sync to PC to sync the panel with the control PC or set the time and date 
manually.

When all the changes have been made, click SAVE or CANCEL at the bottom of the page 
(see figure 36 on page 30).

Passwords

Figure 39.	 Password Settings

This panel is the similar to the Passwords panel for the TLS panels. However, the TLSI can 
have an Admin Password only. There is no User Password.

NOTES:

•	 The factory configured passwords for all accounts on this device have been set to 
the device serial number. Passwords are case sensitive.

•	 If the device is reset to default settings, the passwords are reset to the default 
passwords, which are extron (for either admin or user).

Enter the new password in the Admin Password text box. By default, the new password is 
hidden. To see the new password, click the "eye" icon. 

Enter the new password again in the Confirm Admin Password text box.

The old password is displayed in the textbox underneath each text box.

Click SAVE or CANCEL at the bottom of the page (see figure 36 on page 30).
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Network

The Network tab for both TLS panels and Wayfinding devices is similar:

Figure 40.	 Edit Settings Dialog Box

1.	 Set DHCP to Off or On, as required.

If DHCP is On, the network addresses cannot be edited.

2.	 If DHCP is Off, you can edit the network addresses.

You can edit a single panel or multiple panels.

If you selected a single panel, enter the IP address for that panel.

If you selected multiple panels, enter the IP address that is to be assigned to the first 
panel. The next available IP address is assigned to the second panel and so forth.

For example, if you assign 192.168.254.200 to the first panel, Room Agent assigns 
192.168.254.201 to the second panel unless 192.168.254.201 is already in use. In 
that case the second panel is assigned 192.168.254.202.

3.	 Edit the IP Address, Subnet Mask, Gateway, or DNS Address, as required. You can 
also enter the network address of a domain you wish to search.

If more than one panel was selected, the Subnet Mask, Gateway, and DNS Address 
that you enter is assigned to all the selected panels.

4.	 When all the changes are made, click SAVE or CANCEL at the bottom of the page (see 
figure 36 on page 30).
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Install Firmware
Ensure at least the minimum recommended version of the firmware is installed on all panels.

TIP:	 Check the firmware release notes (at www.extron.com). If the latest firmware 
version adds features that are not needed in your system, updating is optional.

1.	 If you have not already done so, copy the firmware from the Room Agent software 
package to a PC on the same subnet as the panel that you are updating (see Updating 
Firmware on page 18).

Some devices use the same firmware. For example, the TLS 525, TLS 725, and 
TLS 1025 all use the same firmware.

However, other devices use different firmware. For example, the TLSI 201 and the 
TLS 525 use different firmware. You must download the correct firmware file for each 
device.

2.	 To update firmware for one or more panels simultaneously, select one or more panels 
and, in the top menu bar that appears, click Install Firmware.

To edit settings for a single panel, click Actions in the line for that panel and, in the 
drop-down list that appears, click Install Firmware.

3.	 The Install Firmware dialog box opens:

Figure 41.	 Install Firmware dialog box

If you are updating multiple panels simultaneously, they are listed by firmware group. 
For example, all TLS 525M, 725M, and 1025M panels use the same firmware and all of 
those panels are listed under the TLS 525, 725, 1025 heading. In the example above, 
only one panel in this group was selected.

If you are updating a single panel, only that panel is shown.

The Wayfinding devices are listed under the TLSI heading. In the example above, only 
one TLSI was selected.

4.	 Click Browse and navigate to the folder where the firmware file for that group of panels 
was saved in step 1.

5.	 Select the firmware file.

6.	 Click Install. This procedure updates all the panels in a single group.

7.	 To update the firmware for another group of panels repeat steps 3-6.

https://www.extron.com
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Reboot
The device goes through a power cycle. No settings are changed.

1.	 In the top menu bar, click Reboot.

2.	 A dialog box opens asking you to confirm that you wish to reboot the device.

3.	 A power cycle is performed on all the selected devices.

While the reboot is taking place, the text in the Status column changes to 
Connecting....

Once the reboot is complete, the text changes to Reboot Complete. 

Reset
Reset removes any config files uploaded to the device. All other settings (network, firmware, 
and so forth) are unchanged.

1.	 In the top menu bar, click Reset.

2.	 A reset is performed on all the selected devices. While the reset is taking place, the text 
in the Status column changes to Connecting....

Once the reset is complete, the text changes to Reset Complete.
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Configure Tab

This section provides the following information about the Configure tab:

•	 View a List of Touchpanels or Wayfinding Devices and Their Properties

•	 Create or Edit Configuration Files

•	 Set up a Proxy Server

•	 Ad Astra

•	 CollegeNET 25Live

•	 EMS

•	 Google Calendar

•	 Microsoft Exchange

•	 Microsoft Office 365

•	 NFS

•	 Configure Individual TLS Panels

•	 Configure Wayfinding Devices

View a List of Touchpanels or Wayfinding Devices and Their Properties

Touchpanels
By default, the Configure tab opens with TLS Panels (1) selected, to show a list of all the 
panels that were auto-discovered or manually added.

Figure 42.	 Configure Tab — TLS Panels

Use the check boxes (3) at the start of each row to select individual panels or select the 
check box in the column heading to select all panels.

Use the drop-down list (2) to select the calendar associated with the TLS panels.

The options in the top menu bar (2) also change for different calendar types.

See the descriptions for each calendar type to find which options are available with each 
calendar.

figure 42
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Information about the panels is organized under column headings. By default, the column 
headings are STATUS, IP ADDRESS, HOST NAME, ROOM NAME, CAPACITY, LANGUAGE, SOUND, 
TEMPLATE, and LOCATION. These headings may change depending on which Calendar 
Type is selected from the drop-down list (see figure 42, 3, on page 35). For example, 
figure 43 shows the headings with Ad Astra® selected (1).

Figure 43.	 Configure Tab with Ad Astra Calendar

When you check the status box to select a device, a new menu bar appears at the top of 
the page:

Figure 44.	 Configure Tab — Top Menu Bar

•	 Assign Location — Allows you to assign a location tag to the selected TLS panel. The 
location tag allows nearby rooms to be grouped, for example "Floor 1". This is displayed 
as the room location in the Wayfinding Device. When rooms are shown as a list on the 
Wayfinding Device, they are grouped by their location tag.

•	 Apply Template — The layout of the panel can be configured using the Design Tab. 
You can select one of the saved panel design files from this drop-down list.

•	 Send Configuration and Retrieve Configuration — See Sending and Retrieving 
Configurations on page 89.

•	 Retrieve Activity File and Clear Activity File — See Retrieve and Clear the 
Activity File on page 90
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Wayfinding Devices
The options for Wayfinding devices are also different.

Click Wayfinding Devices (1) to view a list of Wayfinding devices.

Figure 45.	 Configure Tab — Wayfinding Devices

For information about configuring Wayfinding devices, see Configure Wayfinding Devices 
on page 92.

Create or Edit Configuration Files
You can create a configuration file and upload it to the TLS panel, where it is saved 
and used to configure that panel. Alternatively, you can download a previously created 
configuration file for editing by clicking Retrieve Configuration. After editing, the configuration 
file is uploaded back to the TLS panel for the changes to take effect by clicking Send 
Configuration.

NOTE:	 Saving each individual configuration file on the corresponding TLS panel is 
a useful feature: if the system configuration file on the control PC is accidentally 
deleted or becomes corrupted, rebuild it by pulling the individual records from all the 
touchpanels.

To configure a TLS panel:

1.	 Click the Panel Configuration button at the top of the page.

2.	 Select a calendar type using the Select a Calendar Type drop-down list. The options 
are:

•	 Ad Astra

•	 CollegeNET 25Live

•	 EMS

•	 Google Calendar

•	 Microsoft Exchange

•	 Microsoft Office 365

•	 NFS
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NOTES:

•	 Depending on the version of Room Agent, you may not see all the calendar types 
listed.

•	 When you select a calendar type, different options appear on the page for 
connecting to the server and for configuring the TLS panels. The next sections 
describe how to configure TLS panels for each calendar type.

After selecting the calendar see Configure Individual TLS Panels on page 89.

Set up a Proxy Server
If you use the https:// protocol to connect a TLS panel to the calendar server, the Proxy 
Server must be setup as TLS Pass Through. This is required for the TLS to validate the 
calendar server’s SSL certificate.

Before Starting
Your proxy server administrator must provide you with the following information:

Proxy Server IP Address/Hostname – This tells the TLS how to find the proxy server.

Proxy Server IP Port – This tells the TLS how to connect to the proxy server.

Protocol(s) (http:// or https://) – This tells the TLS what kind of traffic to send through 
the proxy server.

Proxy Username – The username needed to be allowed through the proxy server.

Proxy Password – The password needed to be allowed through the proxy server.

Setting Up the Proxy Server
1.	 Click the Proxy Setup button ( ). It does not appear until you have selected 

a Calendar Type.

Figure 46.	 Proxy Setup Button
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The Proxy Settings dialog box opens:

Figure 47.	 Proxy Settings Dialog

2.	 Ensure the Proxy Server switch is enabled (1).

3.	 Enter the IP Address/Hostname, Port, Protocols, Username, and Password (see 
Before Starting on page 38). These are only available if the Proxy Server switch is 
enabled.

4.	 Click Save to save any changes and close the Proxy Settings dialog box or click 
Cancel to exit the dialog box without saving changes.

Troubleshooting
If your TouchLink screen cannot communicate to the calendar server through the proxy 
server, check the following:

•	 Can the TouchLink Screen Communicate with the Proxy Server?

•	 Are your proxy credentials correct?
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Can the TouchLink Screen Communicate with the Proxy Server?

Toolbelt is an Extron software product that provides device discovery, device information, 
firmware updates, and configuration of network settings, system utilities, and user 
management for TouchLink Pro devices. For further information, see the Toolbelt Help File.

1.	 Use Toolbelt to test the connection between the TLS and the Proxy server.

Figure 48.	 Toolbelt Utilities — Ping

2.	 Go to Utilities > Proxy Ping.

3.	 Enter the IP Address or Hostname of the proxy server.

4.	 Press Ping.

You should see 4 successful pings as shown above. If you see any error messages, 
your TLS cannot connect to the proxy server. You should check with your network 
administrator.

Are your proxy credentials correct?

1.	 Open the Windows Start menu but do not click any of the icons.

2.	 Type Proxy.

The Start menu provides a manual Proxy setup dialog:

Figure 49.	 Manual Proxy Setup Dialog
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NOTE:	 If you are not an administrator on your PC, or if your PC is managed by 
an IT group, the proxy setting may be locked out. Contact your administrator for 
assistance.

3.	 Enter your proxy information into the Manual proxy setup section.

4.	 Click Save.

5.	 Open a web browser and try to access any external web page (for example, https://
www.extron.com).

You should be prompted to enter your username and password.

6.	 If the username or password is NOT correct, you receive an error message.

If this happens, confirm your username and password with the proxy administrator.

7.	 If your username and password are correct, you are allowed to access the site.

You may also receive a message like This site is blocked by the proxy. This 
means your username and password are correct, but you have tried to access a site 
that is explicitly blocked by the proxy server.

8.	 Once you have confirmed your username and password are correct, you should try to 
access the domain for the calendar server used by the TLS. For example, if you are 
using Microsoft’s Office 365, then use your web browser to open https://outlook.
office365.com.

If you get a message that this site it blocked, you should contact your proxy 
administrator.

Ad Astra 
NOTE:	 To run the Ad Astra calendar type, the TLS touchpanels must have firmware 

version 1.12.0001-b001 (or later) installed.

If you select Ad Astra, you must use the top menu bar (2) to:

1.	 Select a protocol (http:// or https://).

If you use https:// the Proxy Server must be setup as TLS Pass Through. This is 
required for the TLS to validate the calendar server’s SSL certificate (see Set up a 
Proxy Server on page 38).

2.	 Enter the name of the Ad Astra Server.

3.	 Select the SSL Certificate preference (Trusted CA Signed SSL Certificate (Default) 
or No Verification of SSL Certificate).

Figure 50.	 Ad Astra Column Headings

The following column headings (1) are available:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.



Room Scheduling System • Configure Tab 42

 

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.

•	 USER NAME — This is the user name that is used to log into the Ad Astra web 
interface.

•	 PASSWORD — This is the password that is used to log into the Ad Astra web 
interface.

•	 CUSTOMER NAME — This is listed on the Ad Astra web page. In the Main menu bar, 
select Settings > People. From the People List (1), select the required name. This 
is the Customer Name and should be copied and pasted to ensure it is an exact match.

Figure 51.	 Ad Astra Customer Name

•	 SPACE NAME — This is listed on the Ad Astra web page.  In the Main menu bar, 
select Settings > Rooms. From the Room List (1), select the required name. This is 
the Room Name and should be copied and pasted to ensure it is an exact match.

Figure 52.	 Ad Astra Space Name
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•	 EVENT TYPE — This is listed on the Ad Astra web page.  In the Main menu bar, select 
Events > Event Types. From the Master List (1), select the required name. This is the 
Event Type and should be copied and pasted to ensure it is an exact match.

Figure 53.	 Ad Astra Event Type

•	 CAPACITY  — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

•	 TEMPLATE— The layout of the panel can be configured using the Design Tab. You can 
select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

There is also an Actions menu for each touchpanel:

Figure 54.	 Configure Tab —Actions Menu

After verifying that the information is correct for all TLS panels, select one or more panels 
and click Send Configuration to save the configuration on the control PC. Alternatively, 
click Retrieve Configuration to retrieve a previously saved configuration and apply it to 
the selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150).

figure 54
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CollegeNET 25Live
If you select CollegeNET 25Live, you must use the top menu bar (2) to:

Enter the name of the 25Live server in the Server field. This value is the full URL of the 
address you use to log in to your regular CollegeNET 25Live account and has the format: 
https://25live.collegenet.com/<college-name>.

Set up the Proxy Server (see Set up a Proxy Server on page 38).

Figure 55.	 CollegeNET 25Live Column Headings

The following column headings appear in the lists of panels:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.

•	 USER ID — enter the ID for an account that has access to the CollegeNET server. This 
is typically an administrator account.

•	 USER PASSWORD — enter the password for an account that has access to the 
CollegeNET server. This is typically an administrator account.

•	 SPACE NAME — provides the meeting information on the touchpanel. It must match 
exactly the Space Name setup up on the 25Live server. Check the name by searching 
for the Formal Name (1) in the Locations section of 25Live.

111

Figure 56.	 CollegeNET 25Live Space Name

•	 EVENT TYPE — enter the appropriate name for the event type to be used by the 
touchpanel. These are created by the 25Live administrator. Different event types have 
different requirements, such as head counts, features, or registrations, when creating 
bookings.

These requirements are not applicable to ad hoc events.

The requirements for these events are not recognized by Room Agent. For an Event 
Type to correctly coordinate with Room Agent, it cannot have any requirements other 
than the Space Name and Event Type.

Extron recommends using Ad Hoc as an Event Type, but you can create your own Event 
Type on the 25Live server.

Verify the options in the 25Live webpage.
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1.	 Select the Events tab (1).

2.	 Select the Types EDIT link (2).

111
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Figure 57.	 CollegeNET 25Live Event Type

•	 CAPACITY  — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

•	 TEMPLATE— The layout of the panel can be configured using the Design Tab. You can 
select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

There is also an Actions menu for each touchpanel. After verifying that the information is 
correct for all TLS panels, select one or more panels and click Send Configuration to 
save the configuration on the control PC (see figure 54 on page 43). Alternatively, click 
Retrieve Configuration to retrieve a previously saved configuration and apply it to the 
selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150).

EMS

Prerequisites

NOTE:	 Extron recommends the Google Chrome browser for all EMS Web operations.

•	 The EMS Version must be version 44 or higher.

The EMS version can be confirmed by accessing the EMS platform (typically 
http://<your_server_name>/EmsPlatform)

•	 The EMS Platform Services API must be installed.

•	 The EMS Web Administrator must be able to obtain client application information (see 
"Creating a Web Administrator for EMS", below).

•	 The EMS Desktop installer must have Administrator privileges.
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Creating a Web Administrator for EMS
A Web administrator role is required to log into the EMS administrator portal to create client 
IDs. Create a Web Administrator as follows:

1.	 Open the EMS Desktop application and log in as an administrator, with the	
appropriate permissions. The application opens to the Main Menu (see figure 58, 1).

Figure 58.	 Main Menu

2.	 Click Configuration > Everyday User Applications > Everyday Security 
Templates.

The Everyday User Security Templates dialog box opens (see figure 59).
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Figure 59.	 Everyday User Security Templates Dialog Box

3.	 Click New (1).

A new security template dialog box opens.
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Figure 60.	 Security Template Dialog Box

4.	 Enter a description for the security template (see figure 60, 1).

5.	 Click the Roles tab (2).
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The new security role dialog box opens.
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Figure 61.	 New Template Dialog Box

6.	 Click to highlight and select Web Administrator in the left field (see figure 61, 1) and 
click the Move Right button ( >>, 2) to transfer it into the right field.

7.	 Move any other necessary roles to the right field (3).

8.	 Click OK (4).

EMS Setup
If you select EMS (see figure 62, 1), you must select a protocol (http:// or https://) 
(2), and enter the name of the EMS server in the Server field (3). Typically this is 
https://<your_server_name>/EmsPlatform.

If you use https:// the Proxy Server must be setup as TLS Pass Through. This is required 
for the TLS to validate the calendar server’s SSL certificate (see Set up a Proxy Server on 
page 38).

Figure 62.	 EMS Column Headings

The following column headings appear in the lists of panels:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.
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•	 SPACE NAME — This must be the same as the space listed in the EMS server. The 
exact space name can be found using the EMS Desktop Client.

NOTE:	 The list of rooms must be created by the EMS administrator prior to 
appearing in the EMS Desktop Client. If there are any issues getting a Room 
Name, please contact your EMS administrator.

To find the Space Name:

1.	 Open the EMS Desktop Client.

2.	 Select Configuration.

3.	 Select Facilities.

4.	 Click Rooms.

5.	 In the Rooms popup, enter filter options (for example the building name) to shorten 
the list of room names.

The correct Space Name should appear in the Room Name column (see figure 63, 1).

Figure 63.	 EMS Space Name

•	 EVENT TYPE NAME — This is the event type to be used for ad hoc meetings booked 
on behalf of the scheduling panel. The EMS server requires a template name or Event 
Type, when a new meeting is booked. This information can be obtained from the EMS 
Desktop Client.

NOTE:	 The list of Event Types must be created by the EMS administrator prior 
to appearing in the EMS Desktop Client. If there are any issues getting a Room 
Name, please contact your EMS administrator.

1.	 Open the EMS Desktop Client.

2.	 Select Configuration.
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3.	 Select Other.

4.	 Click Event Types.

The Event Types popup lists the event types that can be used on the server. In this 
example, ad hoc is the appropriate Event Type name (see figure 64, 1).

Figure 64.	 EMS Event Types Dialog

5.	 If no event types are listed or you wish to create a new event type, click New (2).

The Event Type dialog box opens:
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Figure 65.	 Event Type Dialog Box

6.	 Enter a name in the Event Type field (see figure 65, 1).

7.	 Check Display to Everyday Users (2) and Available to All Process 
Templates (3).

8.	 Click OK (4).

The dialog box closes and the display returns to the Event Type page.

NOTE:	 Enter this name in the Event Type Name field of the Panel 
Configuration tab. The name is case sensitive.
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•	 CLIENT ID — This is a unique client ID generated by EMS to use the API. It grants a 
secure point for the panels to communicate with the server. Before third-party clients 
can access the EMS API, a valid Client ID must be generated.

NOTES:

•	 You may use the default EMS Web Application ID or a new client can be 
created in the administrator console. The new client must be created by an 
EMS administrator.

•	 You can use a single client for all touchpanels or create multiple clients that are 
each associated with a subset of panels.

1.	 Log in to the administrator console.

2.	 Select Integrations (see figure 66, 1).

Figure 66.	 EMS Administrator Console Home

3.	 Select the appropriate web client. In this example, the default is shown (see 
figure 67, 1).

Figure 67.	 EMS Clients

4.	 To use a new client, click New Integration Client (2).
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The Clients/New page opens:

Figure 68.	 EMS Clients/New Page

5.	 Configure the new client as recommended by your EMS representative.

6.	 How the client is configured depends on your requirements and is beyond the 
scope of this guide. However, to allow touchpanels to make ad hoc bookings, you 
must select  Allow this client to book without Everyday User Templates 
and ignore Booking Rules (see figure 68, 1).

7.	 Click Save Client (2).

8.	 The Clients/New page closes and the EMS Web Clients page opens with the 
new client listed.

9.	 Click the new client.

Whether you clicked on a new or existing client, the Clients/EMS Web 
Application page opens.

The client ID listed (see figure 69, 1) is the one required by Room Agent.

Figure 69.	 EMS Client ID

•	 CLIENT SECRET — This is a number generated by the EMS web site, which is 
required for secure communication between the touchpanels and the EMS calendar 
server.

Click Reset Secret (2).

A pop-up opens, warning This action is permanent. Would you like to 
continue? Click OK.

step 7
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The Client Secret is displayed (it is blurred out in the image below).

Figure 70.	 EMS Client Secret

Copy the Client Secret into the Room Agent CONFIGURE page.

NOTE:	 This is the only time this code is displayed. You must copy it now and store 
it in a safe location to continue using it.

•	 CAPACITY  — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

•	 TEMPLATE— The layout of the panel can be configured using the Design Tab. You can 
select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

There is also an Actions menu for each touchpanel. After verifying that the information is 
correct for all TLS panels, select one or more panels and click Send Configuration to 
save the configuration on the control PC (see figure 54 on page 43). Alternatively, click 
Retrieve Configuration to retrieve a previously saved configuration and apply it to the 
selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150).

Google Calendar
If you select Google Calendar™, you can have multiple devices using the same calendar or 
multiple calendars.

When you use Google, Microsoft Exchange, or Office 365 calendars, you can create private 
meetings. For these meetings, the subject title defaults to Private Meeting and the meeting 
organizer is hidden.

Select a touchpanel and click Authenticate a Device to connect to the calendar that is to 
be associated with that touchpanel. You must have downloaded a JSON file (see Google 
Calendar Overview on page 54 or Step 3: Authenticate a Device to Google on 
page 62).

You may also click View all available accounts, which shows all the Google accounts 
providing the calendars.
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The following column headings appear in the lists of panels:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.

•	 CREDENTIALS —  Google Calendar allows you to use multiple calendars. Select the 
account that is being used for that touchpanel (see Google Calendar Overview on 
page 54).

•	 CALENDAR — Select the calendar for the account that is being used (see Google 
Calendar Overview). 

•	 CAPACITY  — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

•	 TEMPLATE— The layout of the panel can be configured using the Design tab. You can 
select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

There is also an Actions menu for each touchpanel. After verifying that the information is 
correct for all TLS panels, select one or more panels and click Send Configuration to 
save the configuration on the control PC (see figure 54 on page 43). Alternatively, click 
Retrieve Configuration to retrieve a previously saved configuration and apply it to the 
selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150).
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Google Calendar Overview
To use the https:// protocol to connect to Google Calendar, the Proxy Server must be 
setup as TLS Pass Through. This is required for the TLS to validate the calendar server’s 
SSL certificate (see Set up a Proxy Server on page 38).

To authenticate a Room Agent touchpanel to Google, a Google account and a credential 
JSON file are required.

Step 1: Creating Resource Accounts

NOTE:	 This section is required if you wish to use Google Calendar resources with the 
Room Scheduling system. If you are using existing user or personal Gmail account 
calendars, go to Step 2: Creating Access Credentials on page 56.

1.	 Log in to the Google Admin Console at https://admin.google.com/.

2.	 From the Console, select Apps (see figure 71, 1).

Figure 71.	 Google Admin Console

3.	 The Apps menu expands. Click Google Workspace (see figure 72, 1).

Figure 72.	 Apps Window

4.	 Double-click Calendar (see figure 73, 1).

NOTES:

•	 Double-click an app name to configure the service in a new window.

•	 Select or deselect a checkbox to turn the corresponding service off or on.

•	 If Calendar is not available, you need to click Add Service.

https://admin.google.com/
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5.	 The Calendar window opens. Click Resources (see figure 73, 1).

Figure 73.	 Calendar Window

6.	 The Resources window opens. Click + to add a new resource (see figure 74, 1).

Figure 74.	 Resources Window

7.	 The Add resource window opens with a newly created resource. The Auto-
generated resource name (see figure 75, 1) initially shows as -123456789.
contoso.com. The Resource name field (3) is initially empty but is a required field.

As the user enters more information, it is concatenated to the auto-generated 
resource name.

For example, if the user enters room-1 in the Resource name field, the Auto-
generated resource name shows room-1-123456789.contoso.com.

If the user now enters 20 in the optional capacity field, the Auto-generated resource 
name shows room-1-123456789.contoso.com (20).

Figure 75.	 Add resource Window

figure 74

figure 75
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NOTES:

•	 Resources created before or during October 2017 may not have the Category 
set (see figure 75, 2, on the previous page).

•	 In some environments, Auto-generated Resource name (1) may appear as 
Resource name + <Domain> + <Capacity>, if Capacity (4) is entered.

8.	 After adding the information, click ADD RESOURCE (5).

The Add resource window closes. The Resources window (see figure 74 on 
page 55) now lists the new resource that has been added.

NOTE:	 Make a note of the resource name exactly as it appears here. The name is 
required when you set up Room Agent.

Step 2: Creating Access Credentials

NOTE:	 As of December 2021 this information is correct. However, this site is not 
controlled by Extron and may change.

1.	 Open the Google Cloud Platform Dashboard.

Figure 76.	 Google Cloud Platform Dashboard

2.	 Click Go to APIs overview (see figure 76, 1).
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The APIs & Services page opens.

Figure 77.	 APIs & Services page

3.	 Click ENABLE APIS AND SERVICES (see figure 77, 1).

The API Libarary page opens.

Figure 78.	 API Library

4.	 Enter Calendar in the search window (see figure 78, 1).



Room Scheduling System • Configure Tab 58

 

A list of available calendars is shown.

Figure 79.	 Search Results for “Calendar”

5.	 From the search results, select Google Calendar API (see figure 79, 1).

The Google Calendar API page opens.

Figure 80.	 Google Calendar API Page

6.	 Click ENABLE (see figure 80, 1).
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The Overview page opens.

Figure 81.	 Overview Page

7.	 Click the menu icon in the top left corner (see figure 81, 1).

8.	 From the drop-down list, click APIs & Services (2).

The APIs & Services page opens.

Figure 82.	 APIs & Services page

9.	 Click OAuth consent screen (figure 82, 1).

10.	Select the User Type for your app (2), then click Create (3).

11.	Complete the app registration form, then click Save and Continue.

12.	 If you’re creating an app for use outside of your Google Workspace organization, click 
Add or Remove Scopes. Add and verify the authorization scopes required by your app, 
then click Save and Continue.

13.	 If you selected External for user type, add test users:

a.	 Under Test users, click Add users.

b.	 Enter your email address and any other authorized test users, then click Save and 
Continue.

14.	Review your app registration summary. To make changes, click Edit. If the app 
registration looks OK, click Back to Dashboard.
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15.	 In the menu at the left of the screen, click Credentials (see figure 83, 1).

Figure 83.	 APIs & Sevices Page

16.	On the page that opens next, click CREATE CREDENTIALS (see figure 83, 2).

17.	From the drop-down list, click OAuth client ID (3).

The Create OAuth client ID page opens.

Figure 84.	 Create OAuth client ID Page

18.	Click Application type (see figure 84, 1).

The Application type drop-down list opens.

19.	Click TVs and Limited Input devices (2).
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Figure 85.	 Create OAuth client ID Page

20.	Enter a name in the Name field (see figure 85, 1).

21.	Click CREATE (2).

The OAuth client created dialog box opens.

Figure 86.	 OAuth Client Created Dialog Box

22.	Click DOWNLOAD JSON (see figure 89, 1).

23.	Save the json file and make a note of where it was saved.
step 23
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Step 3: Authenticate a Device to Google

1.	 Open Room Agent.

Figure 87.	 Room Agent CONFIGURE Tab

2.	 If necessary, click the CONFIGURE tab (see figure 87, 1).

3.	 Select Google Calendar™ from the Calendar Type drop-down list (2).

4.	 Click Authenticate a Device (3).

The Authenticate a Device to Google dialog box opens.

Figure 88.	 Authenticate a Device to Google dialog box

5.	 Click Browse (see figure 88, 1) and navigate to the location of the JSON file saved in 
step 23 on the previous page.

6.	 Enter the Google Account name (2). This can be any character string that allows you 
to identify the account.

7.	 Click Next (3).

Figure 89.	 User Code

The Authenticate a Device to Google dialog box displays the User Code (see 
figure 89). This code is valid for 30 minutes.

8.	 Click the https://www.google.com/device link.

step 7



Room Scheduling System • Configure Tab 63

 

The Connect a Device dialog box opens.

Figure 90.	 Connect a Device dialog box

9.	 Enter the user code from step 7 on page 62.

10.	Click Next (see figure 90, 1).

The Sign in with Google dialog box opens:

Figure 91.	 Choose an Account

11.	Select an account (see figure 91, 1).
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Figure 92.	 Allow Google to Access your Account

12.	Click Allow to permit Google to access your Google account (see figure 92, 1).

Figure 93.	 Device Connected

When Google is able to connect to your account, the Success! message is shown.

The Sign In with Google window closes and you return to Room Agent.

13.	Click Check Authentication Status.

Figure 94.	 Authentication Complete

Room Agent shows The OAuth Credentials... have been authenticated.

14.	Click OK (see figure 94, 1).
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The new account is added to the list of available accounts and can be viewed by either 
of the following methods:

•	 By clicking View accounts at the top of the CONFIGURE tab (see figure 95).

Figure 95.	 View all available accounts

•	 By clicking on the CREDENTIALS cell of any of the panels listed on the CONFIGURE 
tab. A drop-down list shows the available accounts (see figure 96).

Figure 96.	 Google Account Cell
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Troubleshooting

If a Room Agent configuration has been loaded onto the TouchLink Scheduling Panel but 
the touchpanel is showing that the panel is disconnected (red ellipses in the lower right 
corner of the panel), verify the following items:

•	 Make sure that the Google Account in the Room Agent software and the account that 
approved the User Code in your browser are the same.

•	 Go to https://console.developers.google.com/ and verify that you can see traffic from 
the panel. This updates periodically and shows the requests made to the project that 
was created when setting up the JSON file. 

Figure 97.	 Google Dashboard Showing Traffic from the Panel

If you are using Calendar Resources but only the Google Service Account calendar is 
showing, make sure the “Account Calendar” in Room Agent matches exactly the Calendar 
Resource name as it appears in the Google Admin Console (including special character for 
numbers and occupancy if added when creating the panel).

In order for the TouchLink Scheduling Panel to read the calendar, the Admin account must 
be subscribed to the Room Account Calendar as follows:

1.	 While logged in with the Admin account, go to calendar.google.com

Figure 98.	 Open Other Calendars

2.	 Click the + icon next to the Other Calendars section.

Figure 99.	 Select Subscribe to Calendar

3.	 Click on the Subscribe to calendar option.

https://console.developers.google.com/
https://calendar.google.com
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Figure 100.	 Select Calendar

4.	 Select a calendar from the dropdown list.

Microsoft Exchange
The Extron Room Scheduling System works with the following Microsoft Exchange versions:

•	 Exchange 2007, Service Pack 1

•	 Exchange 2010

•	 Exchange 2013

•	 Exchange 2016

In Exchange servers, the Room Scheduling System uses the Exchange Web Services (EWS) 
protocol to tie in to the server room mailboxes; no plugins or additional software are required 
on the server.

The Room Scheduling System subscribes to the room mailboxes. The EWS protocol 
includes push notifications. The server pushes change notifications to the Room Scheduling 
System whenever calendar changes occur.

NOTES:

•	 Room Agent provides an additional feature when you use the Microsoft Exchange 
or Microsoft Office 365 calendars. In the Design Layout Tab, the drop-down lists 
contain an additional Custom Field option, which displays up to 50 characters from 
the body of the meeting invitation.

•	 When you use Google, Microsoft Exchange, or Office 365 calendars, you can 
create private meetings. For these meetings, the subject title defaults to Private 
Meeting and the meeting organizer is hidden.

•	 With Microsoft Exchange, each conference room is assigned a unique Room 
Mailbox. This is a special type of mailbox that is restricted so that it cannot be used 
for interactive logons (the ability to send or receive emails).

•	 The fully qualified domain name (name@domain.com) must be entered as the user 
ID.

•	 As part of the Room Agent configuration process, the Microsoft Exchange user ID 
and password for each room are entered by the administrator and sent as part of 
the configuration file to the panel. No other user IDs or passwords are used. 

•	 The software encrypts the password; when displayed on the user interface it is 
obscured, and it is encrypted when stored on the administrator PC.

•	 The administrator can choose to save the panel configurations, including the panel 
passwords, on their PC. This file is password protected.
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1.	 If you select Microsoft® Exchange™, additional options appear.

2.	 Click Discover Server (see figure 101, 5) to search for the Microsoft Exchange 
server.

Figure 101.	 Selecting Microsoft Exchange Calendar

If you click Discover Server but Room Agent cannot discover the server 
automatically, a dialog box opens. Enter your email credentials and click Discover.

Figure 102.	 Auto Discover Microsoft Exchange Server Dialog

3.	 Click Protocol (see figure 102, 2) and select http:// or https://.

To use the https:// protocol to connect to the Microsoft Exchange Calendar, the 
Proxy Server must be setup as TLS Pass Through. This is required for the TLS 
to validate the calendar server’s SSL certificate (see Set up a Proxy Server on 
page 38).

4.	 Click Server (3) and enter the address of the server.

5.	 Select whether the SSL Certificate is verified (4). 

Room Agent validates certificates that are signed by trusted Certificate Authorities. If the 
Exchange server is using self-signed SSL certificates, selecting No Verification of 
SSL Certificate bypasses this option. This option should normally left at the default 
selection. If you are unsure, consult the Exchange administrator for the connecting 
server.

6.	 Select the checkbox to Enable Service Account (1) (see Set Up a Service 
Account on page 69).

NOTE:	 The Enable Service Account checkbox allows one or more service accounts 
to be used to configure the panels.

The following column headings appear in the lists of panels:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.

•	 HOST NAME — The host name is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

figure 101
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•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.

NOTE:	 If you select the Enable Service Account checkbox (see figure 101, 1, 
on the previouis page), the Room User ID column heading changes to Service 
Account, and the Room User Password column heading changes to Room 
Resource Account.

•	 ROOM USER ID — enter the ID for an account that has access to the Microsoft server. 
This is typically an administrator account.

User ID requires the User Principal Name (UPN, the name of a Windows network user 
in an SMTP e-mail address format) for the room resource user ID. The UPN must have 
an SMTP e-mail address assigned to it. Abbreviated Exchange User IDs (aliases) do not 
work. (See Verify the Exchange User ID is the UPN on page 73.)

•	 ROOM USER PASSWORD — enter the password for an account that has access to 
the Microsoft server. This is typically an administrator account. 

NOTES:

•	 If service accounts are enabled, the Room User ID and Room User Password 
column headings change to Service Account and Room Resource Account.

•	 The Exchange User ID requires the User Principal Name (UPN: the name of a 
Windows network user in an e-mail address format) for the room resource user 
ID. The UPN must have an SMTP e-mail address assigned to it.

•	 CAPACITY  — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

•	 TEMPLATE— The layout of the panel can be configured using the Design Tab. You can 
select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

There is also an Actions menu for each touchpanel. After verifying that the information is 
correct for all TLS panels, select one or more panels and click Send Configuration to 
save the configuration on the control PC (see figure 54 on page 43). Alternatively, click 
Retrieve Configuration to retrieve a previously saved configuration and apply it to the 
selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150).

Set Up a Service Account
Service accounts, using Impersonation, allow the user to manage multiple  touchpanels 
from a single account. When passwords are updated, only the service account password 
needs to be changed, not the passwords for all the individual touchpanels in the account.

NOTE:	 The service account requires the UPN, the name of a Windows network user in 
an e-mail address format. The UPN must have an SMTP e-mail address assigned to it.
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To set up a service account:

1.	 Select the Status check boxes of the touchpanels to be configured.

2.	 Check the Enable Service Account checkbox (see figure 103, 1). 

When the checkbox is enabled, a new Service Account Manager button (2) 
appears.

3.	 The Room User ID (3) column heading changes to Service Account.

4.	 The Room User Password column heading (4) changes to Room Resource.

5.	 Click Service Account Manager.

Figure 103.			 Microsoft Exchange Service Account

The Service Account Manager dialog opens with the Assign Service Account tab 
selected.

6.	 Enter a Service Account Email (see figure 104, 1).

7.	 Enter a Service Account Password (2).

If you select the Show Password checkbox (3), the characters of the password are 
visible. If you do not select the checkbox, the characters are masked by filled circles.

8.	 Click Add (4).

Figure 104.	 Service Account Manager — Assign Service Account
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The Service Account Email is added to the Service Account dropdown list (see figure 105, 
1).

Figure 105.			 Service Account Email Added to Service Account List

If required, additional service accounts can be created and added to the Service Account 
list.

To assign one or more touchpanels to a service account:

1.	 Select the checkbox next to each of those touchpanels (2).

2.	 Ensure that the correct service account is selected from dropdown menu.

3.	 Click Assign (3).

The service account name appears next to the selected TLS panels (see figure 106, 
1).

Figure 106.	 Service Account Assigned to TLS Panels

4.	 If you wish to assign other touchpanels to another service account, repeat steps 1-3.

5.	 Once all the touchpanels are assigned as required, click Close (2).

steps 1-3
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In the main CONFIGURE tab, the service account associated with the panel is now 
shown.

Figure 107.	 Configure Tab with Service Accounts Added

6.	 Once one or more service accounts have been added, using Manage Service 
Account, you can add that service account from the main CONFIGURE tab. Click on 
the Service Account cell for the appropriate touchpanel. A dropdown menu is now 
accessible, listing all the available Service Accounts.

NOTE:	 In the main Configure tab you can add only one touchpanel at a time to a 
specific service account. With Manage Service Account, you can select multiple 
touchpanels and add them all to a service account simultaneously.

7.	 Enter the room email address in the Room Resource Account column.

NOTE:	 You can assign some TLS panels in your system to service accounts and 
other TLS panels can be individually configured. However, Extron recommends 
that the system configurations used to save TLS panels associated with service 
accounts should be separate from those used to save individually configured TLS 
panels.

Delete a Service Account
1.	 In the Configure tab, click Manage Service Account.

2.	 Click the Edit Service Account tab.

Figure 108.	 Service Account Manager — Edit Service Account

All the available service accounts are listed.

3.	 To delete an account, click on the account. Click the delete (X) button for that row.

figure 108
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Edit a Service Account
1.	 Double-click in the Password field for the service account to be edited (see figure 108 

on the previous page).

2.	 Highlight the password and type a new value.

3.	 Press <Enter> on the keyboard.

TIP:	 The Password field is normally masked (•••). When the existing password 
is deleted, the Show option activated. Click Show to toggle between viewing or 
masking the password characters as you type.

4.	 Click Close to save the changes and exit the Service Account Manager dialog.

Verify the Exchange User ID is the UPN
Verify the UPN as follows:

1.	 Access the Exchange server Active Directory Users and Computers window.

111111111111111111

Figure 109.	 Active Directory

2.	 Click the Find object ( ) icon (see figure 109, 1).
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The Find Users, Contacts, and Groups dialog box opens.

111111111111111111 222222222222222222

333333333333333333 444444444444444444

555555555555555555
Figure 110.	 Find Users, Contacts, and Groups Dialog Box

3.	 Enter the name of the room to be verified in the Name field (see figure 110, 1).

4.	 Click Find Now (2).

The Search results: pane displays the room (3).

5.	 <Right-click> the room in the Search results: pane (4) and click 
Properties (5).
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The Properties dialog box opens.

222222222222222222

333333333333333333

111111111111111111

Figure 111.	 E-mail Address Displayed on the General Tab

6.	 If necessary, click the General tab (see figure 111, 1). The general properties for the 
room are displayed.

7.	 Note the room e-mail address shown (2). This value is the UPN, the value used as the 
only valid Exchange User ID for this room in the Room Scheduling System.

8.	 Click Cancel to exit the display (3).

9.	 Repeat steps 3 through 8 for each desired room.	 .

TIP:	 Write down the UPNs of all rooms for setting up the Room Scheduling 
System.
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Microsoft Office 365
NOTES:

•	 Room Agent provides an additional feature when you use the Microsoft Office 365 
calendar. In the DESIGN Tab, the drop-down lists contain an additional Custom 
Field option, which displays up to 50 characters from the body of the meeting 
invitation.

•	 When you use Google, Microsoft Exchange, or Office 365 calendars, you can 
create private meetings. For these meetings, the subject title defaults to Private 
Meeting and the meeting organizer is hidden.

•	 Microsoft is planning to end single-factor authorization in Oct 2020 and has moved 
to 2-factor authorization (OAuth).

To use Room Agent with Office 365 and OAuth, you must obtain the Tenant ID and 
Client ID for your Azure AD App Registration (see OAuth for Microsoft Office 365 on 
page 77).

After obtaining OAuth credentials from Microsoft, you can assign them to the touchpanels 
(see Assigning OAuth Credentials to Touchpanels on page 86).

If you choose, Microsoft® Office 365™, the address of the server is discovered 
automatically. The server address and protocol (https://) cannot be altered.

To use the https:// protocol to connect to the Microsoft Office 365, the Proxy Server must 
be setup as TLS Pass Through. This is required for the TLS to validate the calendar server’s 
SSL certificate (see Set up a Proxy Server on page 38).

Figure 112.	  Microsoft Office 365 Calendar Server Selected

With Microsoft Office 365, you get the following column headings:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.

•	 CREDENTIALS — This is the name that was used when the device was authenticated 
to Office365 (see Assigning OAuth Credentials to Touchpanels).

•	 CALENDAR — This is the account that provides authorization for Room Agent to 
access the calendar (see Assigning OAuth Credentials to Touchpanels).

•	 CAPACITY — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.
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•	 TEMPLATE— The layout of the panel can be configured using the Design Tab. You 
can select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

After verifying that the information is correct, select one or more panels and click Send 
Configuration.

There is also an Actions menu for each touchpanel. After verifying that the information is 
correct for all TLS panels, select one or more panels and click Send Configuration to 
save the configuration on the control PC (see figure 54 on page 43). Alternatively, click 
Retrieve Configuration to retrieve a previously saved configuration and apply it to the 
selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150).

OAuth for Microsoft Office 365
There are three steps to this process:

•	 Obtaining OAuth Credentials

•	 Assigning OAuth Credentials to Room Agent

•	 Assigning OAuth Credentials to Touchpanels

Obtaining OAuth Credentials

NOTE:	 Microsoft is planning to end single-factor authorization in Oct 2020 and has 
moved to two-factor authorization (OAuth). To obtain OAuth credentials by two-factor 
authorization, follow the steps below.

1.	 Go to https://portal.azure.com/.

2.	 Click Azure Active Directory (see figure 113. 1).

Figure 113.	 Azure Active Directory Portal

https://portal.azure.com/
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The Overview page for your organization opens:

Figure 114.	 Organization Overview Page

3.	 Click App registrations (see figure 114 1).

The App registrations page opens.

Figure 115.	 App Registrations

4.	 Click New registration (see figure 115 1).
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The Register an application page opens.

Figure 116.	 Register an Application Page

5.	 Provide a Name for the App (see figure 116 1). This can be edited later.

6.	 Check the radio button to select from the Supported account types (2). This 
determines who can use the app or access the API.

7.	 You must enter a reply address such as http://localhost (3). This is required for 
Room Agent to work.

8.	 Click Register (4).

The page for your new app opens.

Figure 117.	 New App Page

9.	 Make a note of the Application (client) ID (see figure 117, 1) and the Directory 
(tenant) ID (2). You need these to access the calendar from Room Agent. The 
values have been blurred out in this image.

fibure 117

step 9
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10.	Click Authentication (see fibure 117, 3, on the previous page).

The Authentication page for your app opens.

Figure 118.	 Authentication Page

11.	Select Accounts in this organizational directory (see figure 118, 1).

12.	 In the Advanced Settings, click Yes (2).

13.	Click Save (3).

14.	Click API permissions (4).

The Request API Permissions page opens.

Figure 119.	 Request API Permissions Page

15.	Click Add a permission (see figure 119, 1).

The Request API permissions panel opens (2).

16.	Click Microsoft Graph (3).
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The Request API permissions panel opens.

Figure 120.	 Request API Permissions

17.	Click Delegated permissions (see figure 120, 1).

A list of permission categories opens.

18.	 (Optional) Enter Calendars in the Select permissions text box (2). This narrows the 
number of options listed.

19.	Click Calendars (3) to expand the list of calendar options.

20.	Select the Calendars.ReadWrite and Calendars.ReadWrite Shared check boxes 
(4).

21.	Click Add Permissions (5).

Figure 121.	 Added Permissions Listed

The added permissions are listed (see figure 121, 1).

22.	Click Overview (2).
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Figure 122.	 Get Started

23.	Click Get Started (see figure 123, 1).

Assigning OAuth Credentials to Room Agent

NOTE:	 Microsoft is planning to end single-factor authorization in Oct 2020 and has 
moved to two-factor authorization (OAuth). To obtain OAuth credentials by two-factor 
authorization, follow the steps below.

1.	 Open Room Agent and select the CONFIGURE tab.

Figure 123.	  Microsoft Office 365 Calendar Server Selected

2.	 From the drop-down list of calendars, select Microsoft® Office 365™.

3.	 Enter the calendar server URL path. Usually this is outlook.office365.com, but it is 
not shown in the user interface.

4.	 Click + Add Credentials.

The Authenticate a device to Office 365 dialog box opens.

Figure 124.	 Authenticate a device to Office 365 Dialog

5.	 If necessary, change the credential server URL (see figure 124, 4). The default URL, 
which appears in the user interface is https://login.microsoftonline.com/.

6.	 Provide a Name for the Credentials (1).

7.	 Enter the Client ID (2) and Tenant ID (3), which were obtained in step 9 (see 
page 79) in the previous section.

figure 124
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8.	 Click Get Code (see figure 124, 5, on the previous page).

The dialog displays a QR and a code (see figure 125).

Figure 125.	 Authenticate a Device to Office 365 — QR Code

9.	 Scan the code or enter www.microsoft.com/devicelogin into a browser.

The Microsoft website opens:

Figure 126.	 Select an Account

10.	Select an account (see figure 127).

step 8

step 10

https://www.microsoft.com/devicelogin
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Figure 127.	 Enter Account Password

11.	Sign in to that account (see figure 127).

Figure 128.	 Enter Code

12.	Enter the code for that account (see step 8, on the previous page).

13.	Click Next (see figure 128).

14.	Microsoft requests verification that you are signing in to Room Agent.

Figure 129.	 Verify Room Agent Sign-in

15.	Click Continue (see figure 129).
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Figure 130.	 Microsoft Confirms OAuth Process is Complete

The Microsoft website confirms that the OAuth process is complete (see figure 130).

Figure 131.	 Room Agent Confirms OAuth Process is Complete

The Room Agent Authenticate a device to Office 365 dialog box also confirms 
that the credentials have been authenticated (see figure 131).

16.	Click OK.



Room Scheduling System • Configure Tab 86

 

Assigning OAuth Credentials to Touchpanels

In the Configure tab, use the Credentials drop down list for a touchpanel to ensure that 
the OAuth Credentials match the name given when you authenticated the device to 
Office 365 in step 8 (see page 83) of the previous section. Make sure the Account 
Calendar was the one selected in step 10 on page 83.

Figure 132.	  Assigning OAuth Credentials to Touchpanels

NFS
If you select NFS (see figure 134, 1), you must select a protocol (http:// or https://) 
(2), and enter the name of the NFS server in the Server field (3).

If you use the https:// protocol to connect to the calendar server, the Proxy Server must 
be setup as TLS Pass Through. This is required for the TLS to validate the calendar server’s 
SSL certificate (see Set up a Proxy Server on page 38).

Figure 133.	  Select NFS Calendar Server

The following column headings appear in the lists of panels:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TouchLink panel.

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network.

•	 ROOM NAME — This is the name that appears on the touchscreen, once it is 
configured.
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•	 USERNAME — this is the user name for an account with access to the NFS server. It is 
typically an administrator account.

NOTE:	 The password and User ID are both provided by an NFS administrator. 
These are API credentials that may be the same as the web page login credentials 
but this is not required.

•	 PASSWORD — this is the password for the account with access to the NFS server.

•	 USER ID — this is a field assigned to the user by NFS and required for booking events 
from a panel. The User ID can be a name, such as “Extron User” or it can be an email 
address.

Log on to the NFS server. The User ID is shown in the top right corner (see 
figure 134, 4).

NOTE:	 You need an administrator account to log in to the NFS server.

•	 RESOURCE NAME — this field must match exactly the name set up on the NFS 
server. Check the name by searching for the resource in the NFS server setup. 

a.	 Log on to the NFS server.

Figure 134.	 NFS Home Page

b.	 Click Diary (1).

c.	 Choose a resource group from the drop-down list (2). A list of resources in the 
selected group or groups is shown (3).



Room Scheduling System • Configure Tab 88

 

To add a new resource:

a.	 Click Administration (see figure 135, 1).

Figure 135.	 NFS — Add a New Resource

b.	 Select the Resource Management tab (2).

c.	 Select Resource (3).

d.	 Click Add New Resource (4) and provide the required information.

•	 CAPACITY — Set the maximum number of people allowed in the room in this column.

•	 LANGUAGE — Select an option from the Language drop-down list. By default, the 
language is English.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

•	 TEMPLATE— The layout of the panel can be configured using the Panel Design tab. 
You can select one of the saved panel design files from this drop-down list.

•	 LOCATION — Use a location tag to group nearby rooms, for example "Floor 1". This is 
displayed as the room location in the Wayfinding Device. When rooms are shown as a 
list on the Wayfinding Device, they are grouped by their location tag.

There is also an Actions menu for each touchpanel. After verifying that the information is 
correct for all TLS panels, select one or more panels and click Send Configuration to 
save the configuration on the control PC (see figure 54 on page 43). Alternatively, click 
Retrieve Configuration to retrieve a previously saved configuration and apply it to the 
selected panel.

You can also retrieve or clear the activity file associated with that panel (see Room 
Scheduling Analytics on page 150)
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Configure Individual TLS Panels
Figure 137 shows the Configure tab headings for Microsoft Office 365. A few of the 
column headings depend on the calendar server that was selected. For Microsoft Office 
365, these are Room Name (1), Credentials (2), and Calendar (3). The other headings 
(STATUS, IP ADDRESS, HOSTNAME, CAPACITY, LANGUAGE, SOUND, TEMPLATE, and LOCATION) 
are common for all calendar servers.

Refer to the section about your calendar server for the specific information required for each 
column when configuring the TLS panels for that calendar server.

Figure 136.	  Select Microsoft® Office 365™ Calendar Server

1.	 Select TLS Panels from the menu on the right.

2.	 Select the Status check box for the TLS panel you wish to configure. 

3.	 Enter the correct information in each field. All fields are required. The IP ADDRESS and 
HOSTNAME are usually filled automatically.

4.	 After you have configured one or more panels, you can upload the configuration file to 
the panel and save it there.

•	 To upload the configuration to the touchpanel, click Send Configuration (for 
more information, see Saving Individual Configuration Files to the Appropriate 
Touchpanels on page 89).

•	 If you have previously configured one or more panels and saved your configuration 
to the panel, you can retrieve that configuration file by clicking Retrieve 
Configuration (for more information, see Retrieving a Configuration on 
page 90).

•	 If you have previously configured the entire system and uploaded the individual 
configuration files to the appropriate touchpanels, you can retrieve all the individual 
records from the touchpanels to rebuild the system configuration file.

Sending and Retrieving Configurations

Saving Individual Configuration Files to the Appropriate Touchpanels

Once you have edited one or more configuration files, you can upload the individual files 
to the corresponding touchpanels. That information is used to configure that panel. You 
can retrieve the most recently sent configuration from the panel and save it to the system 
configuration file if the system configuration file gets deleted or becomes corrupted.

Figure 137.		  Sending and Retrieving Configurations

figure 137
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1.	 Click the Actions menu on the line for the touchpanel you have configured.

2.	 Click Send Configuration.

NOTE:	 The Send Configuration button may be unavailable for either of these 
reasons:

•	 The device has not been set up.

•	 All fields must all contain valid values. If one or more of those values is missing, 
the configuration file is incomplete and cannot be sent.

The individual configuration files are uploaded and saved on the touchpanels they apply to.

Alternatively, you can select a touchpanel by selecting the check box at the start of the line. 
From the menu that appears at the top of the page, click Send Configuration.

Retrieving a Configuration

If you have previously configured one or more panels and saved the individual configuration 
files on the corresponding touchpanel, you can retrieve the configuration and save it into the 
system configuration file. 

To retrieve a configuration:

1.	 Click the Actions menu on the line for the touchpanel you have configured.

2.	 Click Retrieve Configuration.

Alternatively, you can select a touchpanel by selecting the check box at the start of the line. 
From the menu that appears at the top of the page, click Retrieve Configuration.

Retrieving Multiple Configurations Simultaneously

To download the complete configuration information from multiple touchpanels at once:

1.	 Select the check boxes next to all the appropriate panels.

2.	  From the menu that appears at the top of the page, click Retrieve Configuration. 
All the individual records are downloaded from the touchpanels to the control PC.

Rebuilding a System Configuration File from Individual Records
If the system configuration file on the control PC is accidentally deleted or becomes 
corrupted, it can be rebuilt by pulling the individual records from some or all the 
touchpanels.

1.	 Select the Status checkboxes for the required touchpanels.

2.	 Click Retrieve Configuration.

The individual records for each touchpanel are pulled back to the control PC.

3.	 Click the Menu button and select Save Configuration.

Retrieve and Clear the Activity File
Each TLS panel maintains an activity file and a log of scheduling information (such as the 
meeting subject, meeting organizer, booking date, meeting date and starting time and 
duration)  among other data for the assigned room. The activity file can be retrieved and 
written to the PC running the Room Agent software as an Microsoft Excel spreadsheet or 
cleared (erased) from the panel. You can use data analytics tools to transform this activity 
data to create usage reports.
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NOTE:	 The panel has 4 Mb of activity file memory. The number of entries varies 
depending on the size of each entry, but may number in the hundreds. When the 
memory becomes full, the newest entries overwrite the oldest. There is no notification 
when the memory becomes full.

Retrieve one or more activity files as follows:

1.	 Select one or more Status checkboxes.

2.	 Click the Retrieve Activity File menu option (see figure 137, on the previous 
page) to fetch the schedule log and from one or more panels and save it in a 
spreadsheet. The Room Agent software opens the Panel Activity File dialog box.

3.	 If required, navigate to the folder where the file is to be saved.

4.	 Enter a name for the retrieved activity file (see figure 138, 1).

5.	 Click Save (2).
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222222222222222222

Figure 138.	  Panel Activity File

The Room Agent software saves the file. It reports that the Status is in progress ( ) 
and then reports Activity retrieved. and All activities have been retrieved 
successfully.

Clear one or more activity files as follows:

1.	 Click the Clear Activity File menu option (see figure 137 on page 89) to erase 
the schedule log from one or more panels.

For the clear operation, the Room Agent software reports that the Status is in progress 
( ) and then reports Cleared. and All panel activity logs have been cleared 
successfully.

2.	 Click OK to exit the clear operation.

For more information, see Room Scheduling Analytics on page 150.

step 4
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Retrieve a template
Templates allow you to create a number of customized panel appearances.

Templates can be designed and saved, using the Configure tab. Once they are saved, 
they are available in the Templates pane.

You can retrieve the template assigned to a panel, for example to use as a starting point for 
designing a new panel layout, as follows:

1.	 Right-click the panel in the Status column.

2.	 Click the pop-up Retrieve Template for Design button. The Retrieve Template 
dialog box opens:

111111111111111111

Figure 139.	 Retrieve Template Dialog Box

3.	 Click Retrieve (see figure 140, 1). Room Agent software displays the Retrieving 
Template ... activity indicator while it loads the template and then automatically 
jumps to the Design tab (see Design Tab on page 98).

Configure Wayfinding Devices
1.	 Open Room Agent.

2.	 Click CONFIGURE.

3.	 Select the Wayfinding Devices button in the menu on the left side of the page.

Figure 140.	 Configure Wayfinding Devices

4.	 Click in the cell in the TEMPLATE column for the device you wish to configure.

5.	 You can choose to display in List or Map format and in landscape or portrait 
orientations. If you have saved other configurations, these are also listed.

Figure 141.	 Wayfinding Device — Design Options

figure 140
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6.	 (Optional) Select the ORIENTATION check box (see figure 140 on page 92). This flips 
the screen from top to bottom (in landscape orientation) or from right to left (in portrait 
orientation). This is useful if the display devices have been pre-installed in an unsuitable 
orientation.

7.	 Click on the Select Rooms link to assign TLS panels to a specific Wayfinding device 
(see Associating TLS Panels with a Wayfinding Device on page 97).

There are seven column headings. These are not affected by the calendar setting:

•	 STATUS — Use this check box to select individual panels for configuration. 

•	 IP ADDRESS — This cell contains the IP address of the TLSI 201 Interface.

•	 HOST NAME — The hostname is a fully qualified domain name that uniquely identifies 
the computer. It is required for the computer to communicate with other devices on the 
network. 

•	 LOBBY NAME — This is the name that appears on the Wayfinding Device, once it is 
configured.

•	 TEMPLATE — Click on this box to open a drop-down list that allows you to select one 
of the saved panel design templates. You can choose one of the List templates or one 
of the Map templates. The templates must have been created in advance (see Design 
Tab for Wayfinding (List Format) on page 113 or Design Tab for Wayfinding 
(Map) on page 121).

This column may also contain a hyperlink, allowing you to organize the room panels 
associated with the Wayfinding Device (see Associating TLS Panels with a 
Wayfinding Device).

•	 Language — The TLSI can be configured to show

•	 A single language.

•	 Two languages side by side.

•	 Multiple languages, one after another.

The default is English as a single language.

1.	 Click the link to open the Language Settings dialog box.

Figure 142.	 Language Settings — Show One Language
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2.	 Select an option by clicking the appropriate radio button.

•	 Show one language — Select a language from the Preferred Language 
drop-down list and click Apply.

•	 Show multiple languages, one at a time

Figure 143.	Language Settings — Multiple Languages

a.	 Click Add Language.

b.	 The Add Language dialog box opens.

By default English is selected. You can remove English by deselecting the box 
and selecting other languages.

c.	 Click Add.

Figure 144.	Add Language Dialog Box



Room Scheduling System • Configure Tab 95

 

The Add Language dialog closes and a list of the selected languages is shown.

When you hover the mouse over one of your choices, you see the list and trash 
icons. You can click on the trash icon to remove the language from the list or click 
and drag the language to a different position in the list.

You can also show the language in Standard (black) font or Highlight color.

In the above example, the Wayfinding device displays information in English, then 
in French, then in Spanish, and finally in Thai, before beginning the cycle again.

•	 Show two languages simultaneously

If you select this radio button, the options are the same as Show multiple 
languages, one at a time but only the first two languages in the Preferred 
Language Order table are available. Any other languages added to the table are 
grayed out and unavailable unless they are moved into the top two.

In this example English and French are shown at the same time and Czech is not 
shown.

•	 SOUND — Set the Sound switch to Off or On. When it is set to on, pressing a button 
provides audible feedback. If it is set to off, there is no sound.

Select the check box next to the Wayfinding Device that you have just configured.

The top menu becomes available.

Click Send Configuration.
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List Format
1.	 Design the Wayfinding display layout (see Design Tab for Wayfinding (List Format) 

on page 113).

2.	 Save the template.

3.	 Assign rooms to the required locations (see Associating TLS Panels with a 
Wayfinding Device on page 97).

4.	 In the Configure tab, select the check box in the Status column that is next to the 
Wayfinding Device that you are configuring.

5.	 Click in the TEMPLATE column for that Wayfinding Device.

Figure 145.	 Wayfinding Device — Template Options

6.	 Select one of the templates shown under the List heading.

7.	 Click Send Configuration.

Map Format
1.	 Design the Wayfinding Device layout (see Design Tab for Wayfinding (Map) on 

page 121).

2.	 If required, create multiple maps to show multiple locations.

3.	 Assign rooms to the map (see Add rooms to the map on page 125).

4.	 Save the template.

5.	 In the Configure tab, select the check box in the Status column that is next to the 
Wayfinding Device that you are configuring.

6.	 Click in the TEMPLATE column for that Wayfinding Device.

7.	 Select one of the templates shown under the Map heading.

8.	 Click Send Configuration.
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Associating TLS Panels with a Wayfinding Device
1.	 Click the hyperlink in the TEMPLATE column.

The Select Rooms dialog box opens:

Figure 146.	 Select Rooms Dialog Box

The rooms are grouped by the location selected in the location column when 
configuring the individual rooms.

All the rooms from a single location are shown by the Wayfinding Device as a single 
group. For example the three rooms shown for the FLOOR 3 location are listed together 
by the Wayfinding Device.

2.	 Select the rooms that are to be displayed by selecting the checkbox next to that room.

The first four rooms shown for the FLOOR 1 location are listed together by the 
Wayfinding Device. The fifth room is not listed because the checkbox was not selected.

3.	 Click and drag the locations into the desired order.

The rooms for the first location in this list are shown on the first screen of the Wayfinding 
Device.

The rooms for the second location are shown on the second screen and so on.

4.	 Click Confirm to save the selection.

The TLSI 201 interface uses Room Agent software to obtain and collate scheduling 
information from individual touchscreens in the system and display that information on a 
large third-party touchscreen.

This provides a centralized display of real-time information about meeting space 
availability, status, and location. Users can locate and book meeting spaces for the day 
or week on an interactive grid or map with ease.

For more information about the TLSI 201, see the TLSI 201 User Guide, at 
www.extron.com.

https://www.extron.com
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Design Tab

The controls in the Design tab allow you to design and configure the appearance and 
function of the TLS panels and Wayfinding devices.

Figure 147.	  Design tab for TLS Panels

To configure the GUI for a touchpanel or Wayfinding Device:

1.	 Open Room Agent and click Design (see figure 147, 1).

2.	 Use the Templates side bar (2) to find available templates for rooms and Wayfinding 
Devices. By default the Design tab opens with Room Templates selected.

The Templates side bar can be collapsed into the side of the window.

3.	 For more information about the Design tab go to the following sections:

•	 Design Tab for Rooms on page 99

•	 Design Tab for Wayfinding (List Format) on page 113

•	 Design Tab for Wayfinding (Map) on page 121
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Design Tab for Rooms
The controls in the Design tab (see figure 148, 1) allow you to design and configure the 
graphical user interface (GUI) for each touchpanel.

Figure 148.	  Design tab for TLS Panels

1.	 If required, select the Design tab.

2.	 Select Templates > Room in the sidebar on the left side of the screen (2).

A list of available room templates opens. Initially there is only one template available, 
called DefaultTLPTemplate. As you create and save your own templates, they are added 
to this menu.

3.	 Select a template from the list. The name of the template that you selected appears in 
the Template Name text box (3).

4.	 Save the template:

•	 If you make changes to the existing template that you wish to save, click Save (4). 
The template is saved with the same name, but incorporating the changes you 
made.

•	 If you make changes to the template that you wish to save as a new template, type 
the new template name into the Panel Template text box and click Save. The new 
template is saved and the original template, without changes, is still available.

•	 If you have retrieved a template, the name shown in the text box is grayed out 
(not selectable). Click Save. The name is shown in normal text and is listed in the 
Templates panel on the left of the screen.

5.	 Use the controls in any of the following Design tabs (5) to configure the GUI 
appearance:

•	 Layout Tab

•	 Options Tab

•	 Background Tab

•	 Date & Time Tab

•	 Panel Message Tab

•	 Room Occupancy Tab

•	 The Preview Panel allows you to see how the configuration affects the appearance 
of the different touchpanel screens.
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Templates Pane
Templates allow you to create a number of customized panel appearances. Each panel 
in a system can have its own template, assigned on the CONFIGURE window. Select the 
templates on the Templates pane.

Figure 149.	  Templates Pane and Drop-down list

•	 To add a new template or rename an existing template:

•	 Type a name in the Panel Template: field.

•	 Click the Save button.

•	 To delete a template, move the mouse over the icon next to the template name in the 
Template list. The icon changes to a trash can. Click on the trash can and confirm that 
you wish to delete the template.

•	 To assign a saved template to a TLS panel, open the Configure tab and select the TLS 
panel. Click in the Design cell for that panel and select a template from the list.

Layout Tab
After you have chosen the Room template, use the Layout tab to assign values to the 
text boxes. Changes to the template are shown in the Preview pane (figure 150, 4, on 
page 101).

NOTES:

•	 When you select Retrieve Template for Design in the Configure tab (see 
Sending and Retrieving Configurations on page 89), the layout tab opens to 
show the template that has been retrieved.

•	 When the tab opens, the name in the Panel Template text box (1) is unavailable, 
even if the name is in the Templates list in the panel on the left side of the window 
(2). Click Save. If a template of the same name is already available, you are asked 
if you want to overwrite the existing version with the downloaded version. If the 
template was not already available, it is added to the list. The name of the template 
in the Panel Template text box (1) is now available.
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Figure 150.	  TLS Layout Tab

Several drop-down lists (3) allow you to select the text that the user sees in the 
corresponding box of the live screen. 

The menu for each box offers the following options:

•	 Room Name •	 Meeting Subject
•	 Meeting Organizer (Display Full 

Name)
•	 Meeting Organizer (Abbreviated 

First Word)
•	 Organization •	 Meeting Duration
•	 Current Date & Time •	 Current Date
•	 Current Time •	 Blank
•	 *Custom Field

* This option is available only when Microsoft Exchange or Microsoft Office 365 is selected 
as the calendar type. It displays up to 50 characters from the body of the meeting invitation.

NOTES:

•	 Any line can be set to any of the values listed above. For example, you can switch 
Meeting Subject and Room Name so that Meeting Subject is in the first box and 
Room Name is underneath it.

•	 If no meeting has been booked, the Meeting Subject field is set to Available 
and the Organizer and Duration fields are blank.

•	 When you use Google, Microsoft Exchange, or Office 365 calendars, you can 
create private meetings. For these meetings, the subject title defaults to Private 
Meeting and the meeting organizer is hidden.

figure 150
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Options Tab
The Options tab (see figure 151, 1) allows users to set options for:

•	 Reserving and extending meetings

•	 Scheduling ad hoc meetings

•	 Enabling the calendar API

•	 Allow room release if meeting called off or ends early

•	 Show room capacity and attendees

•	 Enable PIN

•	 Allow check in to meeting

Figure 151.	 TLS Options Tab 

1.	 Use the Reserve drop-down list (2) to configure how the user can make reservations:

•	 Anytime – Any visible time slot that is open can be reserved by the walk-up user.

NOTE:	 Meeting notices cannot be sent for meetings booked by a walk-up user.

•	 Current time only – Only the currently available time slot can be reserved by the 
walk-up user.

•	 Never – No walk-up reservations are permitted.

2.	 Click Edit to open the Walk-up meeting subject dialog box.

Figure 152.	 Walk-up Meeting Subject Dialog Box

3.	 Enter a  Walk-up meeting subject and click OK. This is the text that appears in the 
Meeting Subject text box when a walk-up meeting is scheduled. It also appears as 
the Meeting Subject on the Wayfinding device.

4.	 Check the Allow time extension box (see figure 151) to allow the room reservation to 
be extended if the meeting goes beyond its scheduled time and the room is free. If this 
box is checked, the Extend until button appears on the panel. Extend until extends 
the reservation of a room in half-hour increments the room is free. The Extend until 
button does not appear if there is a conflict.

figure 151

Reserving and extending meetings

Scheduling ad hoc meetings
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5.	 Check or uncheck the Enable Calendar API checkbox (see figure 151, 3, 
on page 102). When the checkbox is selected, other Extron devices, such as 
IP Link Pro xi control processors, can access the Room Calendar information. The user 
password can be updated from the device MANAGE tab.

NOTE:	 This feature may require a firmware update. Please talk to your Extron 
Representative.

6.	 Several other options can be activated by selecting the appropriate check box (4). 
Check the Allow room release box to allow the user to release the room if the 
meeting is canceled or finishes early.

7.	 Check the Show Attendees box to allow meeting attendees to be seen. This feature is 
available with Google, Microsoft Exchange, and Microsoft Office 365 calendars.

When the box is selected the Show Attendees icon is shown in the preview panel. 
When the touchpanel is configured, pressing the icon displays a list of all the 
participants in the meeting.

8.	 Check the Show Upcoming Meetings box to allow meetings following the current 
meeting to be seen.

9.	 Check the Show Seating Capacity box to display the seating capacity for the room. 
Click the information icon for additional information.

10.	Check the Enable PIN box. When this feature is enabled, the TLS includes a 5-digit 
PIN in the meeting body. This PIN is used for checking in to meetings, releasing 
meetings, and creating ad hoc meetings.

From the drop-down menu, select either:

•	 Save PIN in meeting body

•	 Save PIN in panel

Save PIN in meeting body

This feature is only available when using Microsoft Office365, Microsoft Exchange, or 
Google Calendar.

When enabled, the user is prompted for a five-digit PIN anytime they attempt to 
Reserve, Extend, Check In, or Release the room.

Figure 153.	 Enter PIN

Enabling the calendar API

Allow room release

Show room capacity and attendees

Enable PIN



Room Scheduling System • Design Tab 104

 

When creating an adhoc reservation, the user is prompted to create their PIN. This PIN 
is saved to the meeting body as shown in the figures below. 

Figure 154.	 PIN saved for Office 365

Figure 155.	 PIN saved for Google Calendar

If a meeting is created on the calendar server, the TLS inserts a random PIN into the first 
line of the meeting body.

Any existing content remains intact, below the first line. If the user forgets the PIN or 
wants to change the PIN, they view or change it inside the calendar server interface.

Save PIN in panel

This feature works the same as “Save PIN in Meeting Body” but it does not modify the 
meeting body. The PIN is stored in the TLS memory only.

11.	Check the Allow check in box (see figure 151, 5, on page 102) to allow meetings 
that have been booked in advance to be confirmed and to release the room if nobody 
confirms within a certain time of the scheduled meeting start.

If this box is checked, a Check in button appears on the panel for a scheduled 
meeting. The button disappears from a panel once it is pressed.

Allow check in to meeting
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Click the information icon for additional information.

Figure 156.	 Check In Information Box

Background Tab

Figure 157.	  Background Tab — Light Theme

The Background tab allows you to configure the background of the touchpanel GUI.

1.	 Select the theme color from the Theme Color drop-down menu. The options are:

•	 Light

•	 Buttons are white.

•	 Fonts are black.

•	 Background is white.

•	 When the background image is loaded, the opacity overlay is white.

•	 Dark

•	 Buttons are dark gray with a white border.

•	 Fonts are white.

•	 Background is dark gray.

•	 When the background image is loaded, the opacity overlay is dark gray.

figure 157
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2.	 Click the Change Image button that corresponds to the resolution of your touchscreen, 
to select a background image, or remove the image if one has been previously selected. 

Click on the information symbol ( ) to open a popup box with information about the 
images that can be used. The exact information depends on which touchpanel is being 
used:

•	 Group A (TLS 1025)

Figure 158.	 Background Image Information for 1280x800 TLS Panels

•	 Group B (TLS 725 and TLS 1022)

Figure 159.	 Background Image Information for 1024x600 TLS Panels

•	 Group C (TLS 520, TLS 525, TLP Pro 520, and TLP Pro 720)

Figure 160.	 Background Image Information for 800x480 TLS Panels
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3.	 Set the overlay opacity with the Overlay Opacity slider or text box see figure 157 on 
page 105).

NOTE:	 Take great care in selecting and configuring the background image. Using 
an unsuitable image can make the text placed over the image difficult to read. For 
a complete guide to configuring the background image, see Extron Room Agent 
Background Images Hints and Tips, which is available at www.extron.com. 
Some of the key points are listed here:

•	 Images must be correct resolution for the touchpanel being configured.

•	 Images must be in JPEG, JPG, PNG, or SVG format, with 8 bit colors.

•	 Avoid using images that have vertical or horizontal lines.

•	 Avoid using images that have a great variety of colors.

•	 Avoid using images that have areas of sharp contrast between light and dark

•	 Extron recommends setting the overlay opacity higher than 70% (to make the 
image lighter, if theme color was set to Light, or darker, if theme color was set 
to Dark).

Date & Time Tab
The Date & Time tab (1) allows you to configure the date and time displayed in the TLS 
panels.

Figure 161.	  TLS Panels — Date & Time Tab

1.	 Select the Time format (2). The options are 12-Hour, 24-Hour US, or 24-Hour 
International.

2.	 Select the Room Availability formats from the Start time and End time menus 
(3).

3.	 Select either the Short date or Long date radio button (4) and then select an option 
from the drop-down menus.

https://www.extron.com
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NOTE:	 The abbreviations used below have the following meanings:

•	 d is a single or double digit representation of the day of the month: 1, 2, 3... 31

•	 dd is a double digit representation of the day of the month: 01, 02, 03... 31

•	 dddd is the day of the week: Sunday, Monday, Tuesday... Saturday

•	 M is a single or double digit representation of the month: 1, 2, 3... 12

•	 MM is a double digit representation of the month: 01, 02, 03... 12

•	 MMM is a three-character abbreviation for the month: Jan, Feb, Mar... Dec

•	 MMMM is the complete name of the month: January, February, March... 
December

•	 yy abbreviates the year to two digits: 2015 is shown as 15

•	 yyyy shows the year in four digits: 2015 is shown as 2015

The options are shown below along with how they display Friday, January 02, 2015:

If Short date is selected, the options are:

•	 M/d/yyyy (1/2/2015)

•	 M/d/yy (1/2/15)

•	 MM/dd/yy (01/02/15)

•	 MM/dd/yyyy (01/02/2015)

•	 yy/MM/dd (15/01/02)

•	 yyyy-MM-dd (2015-01-02)

•	 dd-MMM-yy (02-Jan-15)

If Long date is selected, the options are:

•	 dddd, MMMM dd, yyyy (Friday, January 02, 2015)

•	 MMMM dd, yyyy (January 02, 2015)

•	 dddd, dd MMMM, yyyy (Friday, 02 January, 2015)

•	 dd MMMM, yyyy (02 January, 2015)
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Panel Message Tab
By default, if the panel is not connected to a calendar server, the Today’s Availability 
screen displays a message stating This panel device currently has no connection 
with the calendar server.

The Panel Message tab (1) allows the user to edit the message (2), which can be viewed 
in the Preview panel.

You can also return to the default message by pressing Reset to Default (3), or remove 
the message by pressing Clear All (4).

Figure 162.	  TLS Panels — Panel Message Tab

Room Occupancy Tab

Figure 163.	  TLS Panels — Room Occupancy Tab

Use the Room Occupancy tab (1) to:

•	 Allow room occupancy sensor for meeting (2). If this option is selected, other 
options become available:

You can disable the sensor for meetings lasting longer than a user-defined period.

When the room is inactive for a user-defined period, you can select Take no action or 
Release room.

•	 Choose a Sensor Output Type (3).

NOTE:	 At present, this feature works only with the TLS 520M series, TLS 525M series, 
TLS 725M series, and TLS 1025M series TLS panels as other TLS panels do not have 
the digital I/O connectors needed to connect the OCS 100 Occupancy Sensors
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To wire the occupancy sensor, see the diagram on the following page and select the 
corresponding radio button in the Room Occupancy tab.

NOTE:	 The diagrams below show only the configuration of the control connections. 
They do not show power to the sensors or the touchpanels.

Figure 164.	  Connecting Room Sensor to TLS Panel

NOTE:	 Wire colors may be different, depending on the occupancy sensor model.
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Preview Panel
The Preview panel allows you to preview how the user screens appear after configuration.

NOTE:	 The preview pane contains hardcoded, sample, entries. The layout and 
appearance of this pane change to reflect changes in the design pane, but, other than 
the date and time, the contents, such as “Main Conference Room”, do not change.

Select the touchpanel model from the TouchLink Pro menu (1), to preview at the correct 
resolution.

Figure 165.	  TLS Panels — Preview Panel

Use the Preview drop-down list (2) to select which of the seven user screens to preview. 
The choices are:

•	 Available

•	 Outlook Reserved

•	 Confirm Release

•	 Future Reservation

•	 Future Availability

•	 Today’s Availability (No Connection)

•	 Walk Up Reserved

The Preview screen shows the information selected in the Layout tab (3), Options tab 
(4), Date & Time tab (5), and a preview of the next meeting (6).

figure 168
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NOTES:

•	 If Anytime or Current is selected in the Layout tab (see figure 166, 1), the Walk 
Up Reserved screen is available for preview (2).

•	 If Never is selected in the Layout tab (3), the Walk Up Reserved screen is not 
available for preview (4).

•	 If the Allow room release checkbox is not checked, then the Confirm Release 
screen is not available for preview.

Figure 166.	  TLS Panels Preview Screen Options — Reserve Anytime or Never

The screen above shows the Room Available screen using the configuration options 
shown in the screen captures of the Layout, Options, Background, and Date & Time 
tabs.
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Design Tab for Wayfinding (List Format)

Figure 167.	  Design Tab — Wayfinding Device (List Format)

1.	 Click Design (1).

2.	 Click Default (Landscape) (2) in the templates list. The template opens with the 
Layout tab (5) shown.

There are four default templates for the Wayfinding devices. Information is presented 
as a List, in portrait or landscape orientation, or as a map (see Design Tab for 
Wayfinding (Map) on page 121), in portrait or landscape orientation.

3.	 If you modify the default template you can save it with the same name to overwrite the 
default template. Or you can save it with a new name by entering the new name in the 
Template Name textbox (3) and clicking Save.

Once it is saved, the new template becomes available in the Wayfinding > List 
templates.

4.	 Select the Display Size (4). The options are <50", 50"-59", and >59". This option 
is available with all the tabs in all the Wayfinding templates.

5.	 Use the pane on the left of the screen to modify the display. Preview the modifications in 
the pane on the right of the screen.

There are six tabs available to modify the appearance of the Wayfinding List:

•	 Layout tab

•	 Options

•	 Background

•	 Date & Time

•	 Error Message

•	 Permissions

•	 There is also a Preview Pane to show the effect of the modifications.
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Layout tab

Figure 168.	  Wayfinding Devices — Layout Tab

1.	 Click the Layout tab.

The time and date (1) are read only.

2.	 Enter Welcome Text (2), which is displayed on the Wayfinding Device screen.

3.	 Click Upload Logo (3) to place the logo of your organization on the Wayfinding Device 
screen.

4.	 Navigate to the folder where your logo is stored and upload it. The logo must be in 
.bmp, .jpeg, .jpg, .png, or .svg format. The maximum size is 112 pixels (H) x 258 
pixels (W).

5.	 The Room Name (4) is the name of the individual panel that was provided during room 
configuration.

6.	 The current status of each room can be configured to show:

•	 Meeting subject — select Show Meeting Subject to display the Meeting 
subject retrieved from the individual panel. Select Hide Meeting Subject to 
leave the field blank.

•	 Organizer — select Organizer to display the Meeting Organizer retrieved from 
the individual panel. Select Blank to leave the field blank.

•	 Organization — select Organization to display the organization retrieved 
from the individual panel. Select Blank to leave the field blank.

•	 The status of the room during 30-minute period immediately after the current 
session is also shown.

7.	 Adjust the number of rows displayed on each screen (5). The default number depends 
on the screen resolution and whether the screen is in landscape or portrait orientation. 
If the number of rows exceeds the number recommended by the Americans with 
Disabilities Act (ADA), a warning message appears (6), although you are still able to 
adjust the setting.

Changes in the layout can be seen in the Preview Pane (see page 118).
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Options

Figure 169.	  Wayfinding Devices — Options Tab

The Options tab allows you to toggle between:

•	 Show or Hide room Seating Capacity.

•	 Show or Hide a list of Attendees.

Background

Figure 170.	  Wayfinding Devices — Background Tab

1.	 Click Background (1).

2.	 Select the Overview theme color (2). The choices are Light or Dark.

3.	 Select the Accent Color (3). 

You can choose from the Available Colors or click Advanced to create your own 
color.

4.	 Set the Screen Transitions time (4). When multiple pages are displayed as a slide 
show, this determines how long each screen is displayed.

5.	 If changes are made, the Reset button (5) becomes available to restore the settings to 
the previously saved version.

Changes in the layout can be seen in the Preview Pane (see page 118).
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Date & Time

Figure 171.	  Wayfinding Devices — Date & Time Tab

1.	 Click Date & Time tab (1).

2.	 Select the Time Format (2). The choices are

•	 12-Hour

•	 24-Hour US

•	 24-Hour International

3.	 Select either the Short Date or Long Date radio button for the time format used in the 
Wayfinding Device Header (3). The time format associated with the individual rooms 
must be in one of the Short Date formats (4). The options for each drop-down list 
are:

Header Short Date

•	 M/d/yyyy — for example: 5/20/2020

•	 M/d/yy — for example: 5/20/20

•	 MM/dd/yy — for example: 05/20/20

•	 MM/dd/yyyy — for example: 05/20/2020

•	 yy/MM/dd — for example: 20/05/20

•	 yyyy-MM-dd — for example: 2020-05-20

•	 dd-MMM-yy — for example: 20-May-20

Header Long Date

•	 dd MMMM, yyyy — for example: 20 May, 2020

•	 dddd, dd MMMM, yyyy — for example: Wednesday, 20 May, 2020

•	 dddd, MMMM dd, yyyy — for example: Wednesday, May 20, 2020

•	 MMMM dd, yyyy — for example: May 20, 2020

Room Short Date

•	 M/d/yyyy — for example: 5/20/2020

•	 M/d/yy — for example: 5/20/20

•	 MM/dd/yy — for example: 05/20/20

•	 MM/dd/yyyy — for example: 05/20/2020

•	 yy/MM/dd — for example: 20/05/20

•	 yyyy-MM-dd — for example: 2020-05-20

•	 dd-MMM-yy — for example: 20-May-20

Changes in the layout can be seen in the Preview Pane (see page 118).
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Error Message

Figure 172.	  Wayfinding Devices — Error Message Tab

You can customize the messages that are displayed when one of the individual room 
panels goes offline (Panel Disconnected message) or when the Wayfinding Device is 
disconnected (Wayfinding Device Disconnected message).

The default messages are shown in the image above. When you make changes to either 
message, the Reset to Default button becomes available, allowing you to discard any 
changes you have made.

Changes in the layout can be seen in the Preview Pane (see page 118).

Permissions

Figure 173.	  Wayfinding Devices — Permissions Tab

This tab allows you to Enable Touch Interactions and Allow Room Management.

By default, both options are enabled.

NOTE:	 Room management requires to touch interactions to be enabled. If Enable 
Touch Interactions is not selected, Allow Room Management is unavailable for 
selection.
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Preview Pane
The right pane shows previews of various screens that are available. Use the drop-down list 
to select the preview you wish to view. The options are:

•	 Overview

•	 Available Space

•	 Reserved Space

•	 Weekly view

•	 Device Offline

Overview

This view lists all the rooms, in order. If there are too many rooms to be seen on a single 
screen, you can move between screens by pressing the right and left arrows at the bottom 
of the screen.

The rooms can be listed in landscape or portrait orientations.

Figure 174.	  Wayfinding Device List — Landscape View
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Figure 175.	  Wayfinding Device List — Portrait View

•	 A green bar indicates the room is currently available. Information about the next meeting 
is also shown.

•	 A red bar indicates the room is currently occupied. Information about the next meeting 
is also shown.

•	 A gray bar indicates the room is offline and information is not available.

Available Space

Figure 176.	  Wayfinding Device List — Available Space

Press one of the available rooms listed in the overview screen.

The time-line for that room shows when it is available (green bar) or occupied (red bar).

The default view shows the meetings for that day for four hours from the current time. To 
see the room availability for the entire week, press Week.

To reserve the room, press one of the buttons with a green bar to select a period when the 
room is free and then press Reserve.
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Reserved Space

Figure 177.	  Wayfinding Device List — Reserved Space

In the overview, press the room that has been reserved for the meeting.

The time-line shows when the room is available (green bar) or occupied (red bar).

The default view shows the meetings for that day for four hours from the current time. To 
see the room availability for the entire week, press Week.

If the Check In feature has been configured in advance, a Check In button is available.

Press Check In. The room is prepared automatically for the meeting: blinds can be closed, 
lights can be dimmed, as required, computers and projectors can be turned on.

The meeting shown in the figure above is scheduled to finish at 12:30 pm. If the meeting 
is running later than expected and the room is available during the next time slot (12:30 to 
1:00 pm), press Extend to 1:00 PM to reserve the room for an additional 30 minutes.

If the meeting finished early, press Release. This makes the room available for other users.

NOTE:	 These options require the individual room panels to have the Allow check in, 
Allow time extension, and Allow room release options selected in the Rooms Layout 
Tab.

Weekly view

Figure 178.	  Wayfinding Device List — Weekly View

The Weekly view shows room availability, 24 hours each day, for the next seven days, 
starting with the current day.
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Device Offline

Figure 179.	  Wayfinding Device List — Device Offline Preview

This message is displayed if the Wayfinding device is offline.

The message above is the default message. It can be changed in the Error Message tab 
on page 117.

Design Tab for Wayfinding (Map)

Figure 180.	  Design Tab — Wayfinding Device (Map Format)

1.	 Select the Design tab (1).

2.	 Select one of the Wayfinding > Map templates (2). The map can be displayed in 
landscape or portrait orientation, depending on which template you choose.

3.	 Select the display size (4). The options are <50", 50"-59", and >59".

4.	 Use the pane on the left of the screen to modify the display and see a preview of the 
modifications in the pane on the right of the screen.

If you modify the default template you can save it with the same name to overwrite 
the default template. Or you can save it with a new name by entering a new name in 
the Template Name text box (3) and clicking Save (5). Once it is saved, the new 
template becomes available in the Wayfinding > Map templates.
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5.	 Use the pane on the left of the screen to modify the display. The Design tab has seven 
subsections that are accessed by tabs:

•	 Layout

•	 Map

•	 Options

•	 Background

•	 Date & Time

•	 Errors

•	 Permissions

Any changes to the screens can be previewed in the Preview Panel (see page 130) on 
the right side of the screen.

Layout

Figure 181.	  Wayfinding Devices — Layout Tab

1.	 Click the Layout tab (1).

The date and time are read-only.

2.	 Enter Welcome Text (2), which is displayed on the Wayfinding Device screen.

3.	 Click Upload Logo (3) to place the logo of your organization on the Wayfinding Device 
screen.

4.	 Navigate to the folder where your logo is stored and upload it. The logo must be 
in .bmp, .jpeg, .jpg, .png, or .svg format. The maximum size is 112 pixels (H) x 
258 pixels (W).

5.	 To display the meeting subject with a room, toggle the Show Meeting Subject (4) 
switch to the on position. In the map format, the space available for each room can be 
quite small and omitting the meeting subject can save space.

6.	 To enable the Wayfinder display to be toggled between map and list views, set Enable 
Map and List Views (5) to the on position.
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When this is set to on, the panel expands, allowing you to provide meeting details for 
the list view.

Figure 182.	 Wayfinding Devices — Layout Tab expanded

When Enable Map and List Views is set to on, a toggle switch is shown in the bottom 
right corner of the map and list views, allowing the viewer to toggle between the two 
views.

7.	 Adjust the number of rows displayed on each screen. The default number depends 
on the screen resolution and whether the screen is in landscape or portrait orientation. 
If the number of rows exceeds the number recommended by the Americans with 
Disabilities Act (ADA), a warning message appears, although you are still able to adjust 
the setting.

Changes in the layout can be seen in the Preview Panel (see page 130).
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Map
Room Agent provides two sample maps (2) that you can practice on.

There is a standard 2D view:

Figure 183.	  Default Map — 2D

There is also a 3D view:

Figure 184.	  Default Map — 3D

1.	 To upload your own map, click the + symbol in the top right corner of the Maps panel.

The Add New Map dialog box opens:

Figure 185.	 Add New Map Dialog Box

2.	 Click Select File and browse to the location where the map is stored. The map must 
be .jpeg, .png, .bmp, or .svg format.

3.	 Enter a Map Title.

4.	 If required, select the Hide Map check box. This can be used if your map is still a work 
in progress and not ready to be displayed on the screen.

5.	 Click Add to make the map available to Room Agent. The map is now added to the list 
of available maps.

NOTE:	 When you select Hide Map, and then Add, the map is available for you to 
work on but is not shown until the Hide Map check box is no longer selected.

figure 183
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Add rooms to the map

1.	 Select a shape from the Add rooms choices (see figure 183, 1, on page 124). The 
choices are Rectangle, Ellipse, and Custom.

2.	 Click and drag on a space on the map to create an outline to your room (rectangle or 
ellipse).

3.	 To create a custom room, move the mouse and click on each corner. Complete the 
shape by clicking on the first corner again.

When the shape is complete (rectangle, ellipse, or custom) the Room Properties 
dialog box opens, showing the new room:

Figure 186.	 Room Properties Dialog Box

4.	 Until a room has been assigned to the shape, the associated information box is labelled  
Room Name and the shape has the yellow and black warning sign. Once you assign a 
room, that name appears in the information box and the warning sign disappears.

NOTE:	 When you select a room, it is not removed from the TLS list. Be careful not 
to assign the same room to two different locations.

5.	 Click the TLS dropdown list. This contains a list of all the room panels that have not 
been associated with a room on the map.

6.	 Select a room from this list.

7.	 Check the meeting details that you want to appear on the room label. The options are:

•	 Room Name

•	 Meeting Subject

•	 Duration

•	 Organizer

•	 Organization

8.	 Click Save to save the room properties.

The room still appears on the map if you click Cancel.

9.	 To remove the room, right click on the shape and select Delete from the pop-up menu.

If you save a touchpanel room to the new map room, the name of the touchpanel room 
and any information you selected in steps 5-8 are shown on the map.
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10.	Add map assets as required by clicking on an icon in the Map Assets pane and 
dragging it to its place on the map. The assets are:

•	 You are here (yellow star). This is also the position of the Wayfinding Device.

•	 Building entrance and exit

•	 Fire escape

•	 Fire extinguisher

•	 Elevator

•	 Stairs

•	 Rest rooms

11.	To save your changes, enter a name in the Template Name text box and click Save.

12.	After saving the template, you must return to Configure tab to save the configuration.

Duplicate Maps

If you have two or more floors of the same building with the same room layout, you can 
duplicate a map and assign the appropriate rooms to each version.

For example, each version of the map can be used for a separate location: Floor 1, Floor 2, 
etc. The Wayfinding Device allows you to scroll through the different maps to find the 
location of your room on the correct floor. 

To duplicate a map, right click on the file listed in the Maps pane in the top right corner of 
the screen and select Duplicate from the drop-down menu. The file is automatically saved 
with a new name. 

To edit the name assigned to the new map, right click the file name and select Edit. The 
Edit Map dialog  box is identical to the Add New Map dialog box.

Edit the Map Title text box and click Save.

Options

Figure 187.	  Wayfinding Devices — Options Tab

The Options tab allows you to toggle between:

Show or Hide room Seating Capacity.

Show or Hide a list of Attendees.
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Background
The background tab allows you to set:

Figure 188.	  Wayfinding Devices — Background Tab

Theme Overview:

•	 light

Figure 189.	  Wayfinding Devices — Theme Overview (light)

•	 dark

Figure 190.	  Wayfinding Devices — Theme Overview (dark)
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Accent Color – You can choose from the Available Colors or click Advanced to create 
your own color. 

Screen Transitions time – When multiple pages are displayed as a slide show, this 
determines how long each screen is displayed.

Changes in the layout can be seen in the Preview Panel (see page 130).

Date & Time

Figure 191.	  Wayfinding Devices — Date & Time Tab

1.	 Click Date & Time.

2.	 Select the Time Format. The choices are:

•	 12-Hour

•	 24-Hour US

•	 24-Hour International

3.	 Select either the Short Date or Long Date radio button for the time format used in the 
Wayfinding device Header. The time format associated with the individual rooms must 
be in one of the Short Date formats. The options for each drop-down list are:

Header Short Date

•	 M/d/yyyy — for example: 5/20/2020

•	 M/d/yy — for example: 5/20/20

•	 MM/dd/yy — for example: 05/20/20

•	 MM/dd/yyyy — for example: 05/20/2020

•	 yy/MM/dd — for example: 20/05/20

•	 yyyy-MM-dd — for example: 2020-05-20

•	 dd-MMM-yy — for example: 20-May-20

Header Long Date

•	 dd MMMM, yyyy — for example: 20 May, 2020

•	 dddd, dd MMMM, yyyy — for example: Wednesday, 20 May, 2020

•	 dddd, MMMM dd, yyyy — for example: Wednesday, May 20, 2020

•	 MMMM dd, yyyy — for example: May 20, 2020
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Room Short Date

•	 M/d/yyyy — for example: 5/20/2020

•	 M/d/yy — for example: 5/20/20

•	 MM/dd/yy — for example: 05/20/20

•	 MM/dd/yyyy — for example: 05/20/2020

•	 yy/MM/dd — for example: 20/05/20

•	 yyyy-MM-dd — for example: 2020-05-20

•	 dd-MMM-yy — for example: 20-May-20

Errors

Figure 192.	  Wayfinding Devices — Errors Tab

You can customize the messages that are displayed when one of the individual room panels 
goes offline (Panel Disconnected message) or when the Lobby panel is disconnected 
(Lobby Panel Disconnected message).

The default messages are shown in the image above. When you make changes to either 
message, the Reset to Default button becomes available, allowing you to discard any 
changes you have made.

Changes in the layout can be seen in the Preview Panel (see page 130).
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Permissions

Figure 193.	  Wayfinding Devices — Permissions Tab

This tab allows you to Enable Touch Interactions and Allow Room Management. By 
default, both options are checked.

NOTE:	 Room management requires touch interactions to be enabled. If Enable Touch 
Interactions is not selected, Allow Room Management is unavailable for selection.

Preview Panel
The right pane shows previews of various screens that are available. Use the drop-down list 
to select the preview you wish to view. The options are:

•	 Map

•	 Available Space

•	 Reserved Space

•	 Weekly view

•	 Device Offline

Map

Figure 194.	  Wayfinding Device Map — Map Preview

The map preview shows the current version of a saved map. It can be the sample map that 
was used for practice or a map that accurately reflects your workspace. If Enable Map and 
List Views is on, a toggle switch is seen in the bottom right corner. This allows viewers 
using the Wayfinder screen to toggle between the map view and list view.
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Available Space

Figure 195.	  Wayfinding Device Map — Available Space

Press one of the available rooms listed in the overview screen.

The timeline for that room shows when it is available (green bar) or occupied (red bar).

The default view shows the meetings for that day for four hours from the current time. To 
see the room availability for the entire week, press Week.

To reserve the room, press one of the buttons with a green bar to select a period when the 
room is free and then press Reserve.

Reserved Space

Figure 196.	  Wayfinding Device Map — Reserved Space

In the overview, press the room that has been reserved for the meeting.

The timeline shows when the room is available (green bar) or occupied (red bar).

The default view shows the meetings for that day for four hours from the current time. To 
see the room availability for the entire week, press Week.

If the Check In feature has been configured in advance, a Check In button is available.

Press Check In. The room is prepared automatically for the meeting: blinds can be closed, 
lights can be dimmed, as required, computers and projectors can be turned on.

The meeting shown in the figure above is scheduled to finish at 12:30 pm. If the meeting 
is running later than expected and the room is available during the next time slot (12:30 to 
1:00 pm), press Extend to 1:00 PM to reserve the room for an additional 30 minutes.

If the meeting finished early, press Release. This makes the room available for other users.

NOTE:	 These options require the individual room panels to have the Allow check 
in, Allow time extension, and Allow room release options selected in the Rooms 
Layout tab.
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Weekly view

Figure 197.	  Wayfinding Device Map — Weekly View

The Weekly view shows room availability, 24 hours each day, for the next seven days, 
starting with the current day.

Device Offline

Figure 198.	  Wayfinding Device Map — Device Offline Preview

This message is displayed if the Wayfinding device is offline.

The message above is the default message. It can be changed in the Errors tab on 
page 129.
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Hardware

This section provides an overview for installing the hardware. For more information, see the 
user guide for that product, which is available at www.extron.com. The topics covered in 
this section are:

•	 TLS Panels

•	 TLSI Panels

As of January 2022, Extron recommends the following TLS panels for use with the 
Room Agent software:

•	 TLS 525M and TLS 525M NC

•	 TLS 725M and TLS 725M NC

•	 TLS 1025M and TLS 1025M NC

Check with www.extron.com to see a list of the latest recommended TLS panels.

Room agent also supports the TLSI 201 Wayfinding device.

TLS Panels
The Extron TLS 525M, 725M, and 1025M are wall mounted, capacitive touchpanels with 
TFT active matrix color LCD screens with 24-bit color depth.

•	 TLS 525M — A 5‑inch (measured diagonally) panel with an 800x480 capacitive glass 
touchscreen.

•	 TLS 725M — A 7‑inch, panel with an 1024x600 capacitive glass touchscreen.

•	 TLS 1025M — A 10‑inch panel with a 1280x800 capacitive touchscreen.

NOTE:	 For use in a high-security environment, the camera, Bluetooth, and microphone 
have been removed from the TLS 525M NC, 725M NC, and 1025M NC models. In all 
other respects, they are identical to the standard models.

Information about mounting and basic setup for these panels is shown on the following 
pages. For complete information, see the TLP Pro 525, 725, and 1025 Series User Guide at 
www.extron.com.

These models ship with the latest firmware for the scheduling system. No firmware update is 
required.

The following panels are retired but still supported by the Room Agent software.

•	 TLS 520M (see TLP Pro 520, 720, and 1020 Series User Guide at www.extron.com)

•	 TLP Pro 520M (see TLP Pro 520, 720, and 1020 Series User Guide)

•	 TLP Pro 720M (see TLP Pro 520, 720, and 1020 Series User Guide)

•	 TLP Pro 720T (see TLP Pro 520, 720, and 1020 Series User Guide)

•	 TLS 1022M (see TLP Pro 1022 Series User Guide)

•	 TLS 1022T (see TLP Pro 1022 Series User Guide)

https://www.extron.com
https://www.extron.com
https://www.extron.com
https://www.extron.com
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Setup Checklist

Get Ready

•	 Download and install the latest version of the following software onto the PC being used 
to configure the TouchLink panel:

•	 Toolbelt — Provides device discovery, device information, firmware updates, 
and configuration of network settings, system utilities, and user management for 
TouchLink Pro devices and scheduling panels. 

•	 Room Agent — Free room booking software for configuring the panels for room 
scheduling.

NOTE:	 Both these software programs and supporting documentation are available from 
www.extron.com.

•	 Obtain the following network information from your network administrator:

•	 DHCP status — (on or off). If DHCP is off, you must also obtain:

•	 IP address •	 Subnet mask •	 Gateway

•	 User name — This can be either admin or user.

•	 Password  — The factory configured passwords for all accounts on this device have 
been set to the device serial number. Passwords can be changed during configuration. 
Passwords are case sensitive.

NOTE:	 If the device is reset to default settings, the password is the default 
password configuration. The default password is extron (for both admin or 
user).

•	 Make a note of the Touchpanel MAC address, which can be found on a rear-panel label.

•	 SSL security certificates and IEEE 802.1X authentication — TLS panels come 
with a factory-installed Secure Sockets Layer (SSL) security certificate. IEEE 802.1X 
authentication is also supported once enabled. See Secure Sockets Layer (SSL) 
Certificates on page 153 or see IEEE 802.1X Certificates on page 154 for more 
information.

Mount and Cable All Devices

ATTENTION:

•	 Do not power on the TouchLink panels until you have read the Attention in the “Rear 
Panel Features” section of the TLP Pro 525, 725, and 1025 Series User Guide.

•	 Ne branchez pas les écrans tactiles avant d’avoir lu la mise en garde dans la section 
« Rear Panel Features » du TLP Pro 525, 725, and 1025 Series User Guide.

•	 Mount the units. There are several mounting options for TouchLink panels (see 
Mounting on page 135). 

•	 Connect the TouchLink panel to a Power over Ethernet injector.

•	 Connect the power injector to the LAN and power it on.

Set up the TouchLink Panels for Network Communication

•	 Connect the PC that you are using for setup, the control processor, and the touchpanel 
to the same Ethernet subnetwork.

•	 Use Room Agent Network settings (see page 32), the touchpanel Setup Menu 
(see page 141), or Toolbelt (see the Toolbelt Help File) to set the DHCP status and, if 
required, network addresses for the TouchLink panel.

http://www.extron.com
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Configure the TouchLink Panels

The Room Agent Manage Tab (see page 21) and Toolbelt Help File provide information 
about configuring these panels.

Mounting
All these panels can be wall-mounted, either using a UL-listed junction box, an external 
wall box, or directly into drywall or furniture. Suitable mounting accessories can be found at 
www.extron.com. 

ATTENTION:

•	 Do not install TouchLink panels in a fire resistant rated wall or partition assembly.

•	 Veuillez ne pas installer les écrans TouchLink dans un mur protégé par un 
dispositif coupe-feu ou dans une cloison.

•	 All structural steps and electrical installation must be performed by qualified 
personnel in accordance with local and national building codes and electrical 
codes.

•	 Toute étape structurelle et installation électrique, doit être effectuée par un 
personnel qualifié, conformément aux codes du bâtiment, aux codes incendie et 
sécurité, et aux codes électriques, locaux et nationaux.

With a Wall Box or Junction Box

Some local building codes require the TouchLink panel to be mounted in a junction box. 
Junction boxes or wall boxes must be purchased separately. In figure 199, on page 136, 
mounting the TLS 725M to a wall box is shown. Installation for the other panels is very 
similar.

NOTES:

•	 The 5 inch models mount to a 1-gang junction box. The US 1-gang junction box 
should be installed so that the long side is horizontal. EU or MK 1-gang junction 
boxes should be installed in the standard orientation.

•	 The 7 and 10 inch models mount to a 2-gang junction box.

•	 Extron provides four 3/4" #6-32 Philips pan head screws for mounting to US 
junction boxes.

•	 Extron provides two 16 mm M 3.5 Philips pan head screws for mounting to MK 
junction boxes.

•	 EU junction boxes are usually provided with their own screws.

https://www.extron.com
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Figure 199.	  Mounting the TLS 725M with a wall box

Mounting the TLS panels with a wall box 

1.	 Install a junction box or wall box (see figure 200, 1), following the instructions provided 
by the manufacturer.

2.	 Fasten the mounting plate to the wallbox (2) with the provided screws. Use the 
mounting holes that are appropriate to the junction box you are using (see figure 200 
on page 137).

3.	 Run and connect cables to the back of the touchpanel (see Rear Panel Features on 
page 139).

The mounting plate for the 5 inch touchpanel has two hooks (one in each top corner). 
The mounting plate for the 7 and 10 inch panels has four hooks (3), one in each 
corner (see figure 200).

4.	 Position the touch panel so that the mounting slots (see figure 202, D, on page 139) 
in the rear of the TouchLink panel align with these hooks.

5.	 Move the TouchLink panel inward and downward so that the panel sits securely on the 
hooks, and the tongue at the bottom of the mounting plate (see figure 200, 4) sits in 
the groove in the bottom of the panel (see inset, 5).

6.	 Fasten the TouchLink panel to the mounting plate with the lock screw (6).

figure 199

steps 3 through 6
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Figure 200.	  Mounting Plates for 5 inch models (left) and 7 or 10 inch models (right)

NOTE:	 The TLS 725M and TLS 1025M TouchLink panels use the same mounting plate.

Mounting the TLS panels without a wall box

If the wall box is not required by local building codes, you can mount the touchpanel directly 
into drywall. 

1.	 Use the mounting plate as a template to mark the wall or download the cut-out 
template for your product from www.extron.com. Place the template or mounting 
plate against the wall or furniture in a suitable location and ensure that it is level. 

2.	 Mark the position of the hole and cut the wall.

•	 For the TLS 525, this hole is 2.4 inches (61 mm) wide x 2.1 inches (53 mm) high.

•	 For the TLS 725 or 1025, this hole is 3.5 inches (89 mm) wide x 2.0 inches (51 mm) 
high.

3.	 Mark the slots labeled WALL (5 inch models) or MK (7 or 10 inch models) (see figure 4) 
and drill the pilot holes. Extron recommends using Molly bolts or SnapToggle bolts.

4.	 Secure the mounting plate to the wall (see figure 199, 2, on page 136).

5.	 Complete the installation as described in steps 3 through 6 on page 136.

figure 200

https://www.extron.com
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Front Panel Features

NOTE:	 Figure 204 shows the front panel of the TLP Pro 725M. The front panels of all 
the TouchLink panels have the same features and are almost identical apart from the 
size.

Extron

AAA BBB AAA

CCC

DDD DDD

Figure 201.	  TLP Pro 725M Front Panel

A	 Motion sensor — Detects motion between three to five feet from the TouchLink panel, 
and at least 15° from the center axis.

If the sleep timer has been set (see Setup Menu on page 141), and no motion has 
been detected for a user-defined period of time, the TouchLink panel enters sleep 
mode.

If Wake on Motion has been set (see Setup Menu), and motion is detected by the 
sensor while the screen is in sleep mode, the screen display is restored and active.

B	 Light sensor — Monitors ambient light level and adjusts screen brightness.

C	 Capacitive touchscreen

The TLS 525M has a 5 inch screen with a 800x480 resolution.

The TLS 725M has a 7 inch screen with a 1024x600 resolution.

The TLS 1025M has a 10.1 inch screen with a 1280x800 resolution

D	 Status lights — Two LED light bars, one on either side of the screen. The LEDs light 
green when the room is currently available and red when the room is currently booked. 
They cannot be programmed.

figure 201



Room Scheduling System • Hardware 139

 

Rear Panel Features

NOTE:	 The panels shown in figure 203 are for illustration only and are not to the same 
scale.

For more information, follow the links on the right to the next page.
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Figure 202.	  TLS 525M, 725M,  and 1025M Rear Panels

figure 202

A MENU button

B RESET button

C RESET LED

D Mounting slots

E Digital input monitoring 
port

F LAN/PoE connector

G USB port

H Speaker

I Slot for mounting plate

J Mounting screw

K Rear panel status lights
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A	 MENU button (see figure 202 on page 139)— Activates the setup menu (see Setup 
Menu on page 141).

B	 RESET button — Pressing the RESET button allows the unit to be reset in any of three 
different modes (for an overview, see Reset Modes on page 141).

C	 RESET LED — Provides feedback about the reset status when the user presses the 
RESET button (see Reset Modes).

D	 Mounting slots — The TLS 725M and TLS 1025M have four, one in each corner. The 
TLS 525M has two, one in each top corner. The hooks on the corners of the mounting 
plate (see figure 199, 3 on page 136) fit into these slots for wall mounting.

E	 Digital input monitoring port — This two-pole captive screw port (1 = signal and 
G = ground) monitors digital input with or without a +5 VDC pull-up. 

F	 LAN/PoE connector — Connect the TouchLink panel to a PoE power injector (not 
provided) using a twisted pair cable, terminated with an RJ‑45 connector. Connect the 
power injector to the LAN through a network switch.

ATTENTION:

•	 The TouchLink panels are Power over Ethernet (PoE 802.3af, class 3) 
compliant. Do not power on the touchpanels until you have read the Attention 
in the “Rear Panel Features” section of the TLP Pro 525, 725, and 1025 
Series User Guide.

•	 Les écrans TouchLink supportent l’alimentation via Ethernet (PoE 802.3af, 
classe 3). Veuillez lire la partie « Attention » dans la section « Rear Panel 
Features » du TLP Pro 525, 725, and 1025 Series User Guide, avant de 
mettre sous tension les écrans tactiles.

NOTE:	 The TLS panels ship without a power injector. The power injector must be 
purchased separately. Extron recommends the Extron XTP PI 100 power injector 
(see figure 206). Your power injector may look different.

100-240V ~ 50-60Hz
0.4A MAX

XTP

PWR

XTP PWR

To network switch To TLS panel

Figure 203.	 XTP PI 100 Power Injector

G	 USB port — Compatible with USB 2.0. 

H	 Speaker — Provides audible feedback for the user. The TLS 525M and 725M each 
have a single speaker. The TLS 1025M has two (dual mono) speakers

I	 Slot for mounting Plate — The tongue at the bottom of the mounting plate (see 
figure 199, 4) fits into this slot, for wall mounting.

J	 Mounting screw — Tightens against the tongue of the mounting plate to secure the 
touchpanel.

K	 Rear panel status lights — These lights can be disabled for glass mount applications.

•	 TLS 525M — no lights

•	 TLS 725M — Six lights, three on each side of the panel

•	 TLS 1025M — Two lights, one on each side of the panel

The LEDs light green when the room is currently available and red when the room is 
currently booked. They cannot be programmed. 

MENU button

RESET button

RESET LED

Mounting slots

Digital input monitoring port

LAN/PoE connector

USB port

Speaker

Slot for mounting plate

Mounting screw

Rear panel status lights
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Reset Modes
These touchpanels provide the following reset modes (see the TLP Pro 525, 725, and 1025 
Series User Guide for complete information):

Use Factory Firmware — With the unit powered off, press and hold the RESET button 
(see figure 202, B on page 139) while reapplying power to the unit. Use this mode 
with Toolbelt software to replace firmware in the event of conflicts arising from uploading a 
firmware update.

Reset All IP Settings — Press and hold the RESET button for 6 seconds. After the RESET 
LED (C) blinks twice, release and momentarily press the RESET button. Use this mode to 
reset all network settings without affecting user-loaded files.

Reset to Factory Defaults — Press and hold the RESET button for 9 seconds. After the 
RESET LED blinks three times, release and momentarily press the RESET button. Use this 
mode to return the TouchLink panel to factory default settings.

NOTES:

•	 The factory configured passwords for all accounts on this device have been set to 
the device serial number. Passwords are case sensitive.

•	 If the device is reset to default settings, the password is the default password 
configuration. The default password is extron (for either admin or user).

Enable or Disable the DHCP Client — This mode toggles between DHCP enabled and 
DHCP disabled. Press the RESET button five times, consecutively. After the fifth press, do 
not press the button again within 3 seconds. If DHCP was enabled, it is now disabled and 
the Power LED blinks three times. If DHCP was disabled, it is now enabled and the Power 
LED blinks six times.

Setup Menu
Figure 207 shows the Status screen for the TLS 725M. The screens for the TLS 525M, 
TLS 1025M are similar.

Press the MENU button (see figure 202, A) to open the setup menu. Select any of the five 
available screens (Status, Network, Display, Audio, and Advanced) by pressing the 
appropriate button in the navigation bar at the top of the screen (for more information, see 
the TLP Pro 525, 725, and 1025 Series User Guide).

Status Display Audio Advanced ExitNetwork

Info

Model: TLS 725M

Part Number: 60-1563-102

Firmware
Version: 1.02.0001-b001

Network

IP Address:
DHCP:
Host Name:

Off
192.168.254.251

TLS-AB-CD-EF

Display

Resolution:
GUI Project:
Sleep Timer:

1024x600
N/A
5 Minutes

Audio

System Volume:
System Mute: Off

99

Advanced

Controller IP: N/A
Project Size: N/A

Bootloader
Version: 1.03.0000

Figure 204.	  Setup Menu: Status Screen for TLS 725M
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TLSI Panels
The Extron TLSI 201 Interactive Wayfinding Interface provides real-time meeting space 
availability, status, and location information using a centralized display. The TLSI 201 
communicates over the Ethernet network directly with Extron TLS room scheduling panels 
and shows information about the TouchLink scheduler system on third-party touch and 
non-touch displays. The interface supports resolutions up to 4K.

Users can locate and book meeting spaces for the day or week on an interactive grid or 
map with ease. No additional programming or external processors are required.  

This guide provides instructions for experienced installers to mount the TLSI 201 and to 
create a basic configuration. For more complete instructions, see the TLSI 201 User Guide, 
at www.extron.com.

Setup Checklist

Get Ready

•	 Download and install the latest version of the following software:

•	 Room Agent — Room booking software for configuring the TLSI 201 for 
room scheduling. Room Agent can be downloaded (free of charge) from 
www.extron.com. 

•	 Obtain the following network information from your network administrator:

•	 DHCP status — (on or off). If DHCP is off, you must also obtain:

•	 IP address •	 Subnet mask •	 Gateway

•	 Username — This can be either admin or user.

•	 Password  — The factory configured passwords for all accounts on this device 
have been set to the device serial number. Passwords can be changed during 
configuration. They are case sensitive.

NOTE:	 If the device is reset to default settings, the passwords are reset to the 
default password, which is extron (for either admin or user).

•	 Make a note of the MAC address for the TLSI 201.

•	 SSL security certificates and IEEE 802.1X authentication — TLSI 201 comes 
with a factory-installed Secure Sockets Layer (SSL) security certificate. IEEE 802.1X 
authentication is also supported once enabled. See Secure Sockets Layer (SSL) 
Certificates on page 153 or see IEEE 802.1X Certificates on page 154 for more 
information.

Mount and Cable All Devices

•	 Mount the units. The TLSI 201 can be discretely mounted behind a flat panel display. 
For available mounting options see the TLSI 201 product page at www.extron.com.

To mount the third-party touchpanel follow the instructions provided by the 
manufacturer. 

•	 Connect cables to the TLSI 201 (see Rear Panel Connectors and Features on page 
143).

•	 Connect the HDMI output from the TLSI 201 to the third-party touchpanel.

•	 Connect the USB port from the TLSI 201 to the third-party touchpanel.

NOTE:	 The USB connection passes information to the TLSI 201 about where on 
the screen the third-party touch display was pressed. If using a non-touch display, 
connect a USB mouse to the USB port on the TLSI 201 to click screen icons.

https://www.extron.com
https://www.extron.com
https://www.extron.com
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•	 Connect the Ethernet cable. The TLSI 201 must be powered by PoE+.

ATTENTION:

•	 Do not power on the TLSI 201 until you have read the Attention in the Rear 
Panel Features section of the TLSI 201 User Guide.

•	 Ne branchez pas le TLSI 201 avant d’avoir lu la mise en garde dans la section 
« Rear Panel Features » du TLSI 201 User Guide.

Set up the TLSI 201 for Network Communication

•	 Connect the PC used for setup on the same Ethernet subnetwork as the TLSI 201.

•	 Use the Setup Menu (see page 147) to set the DHCP status and, if necessary, the IP 
address, subnet mask, gateway, and related settings for the network interface. You can 
also configure these settings in Room Agent.

•	 Configure the User Interface, using the Room Agent software.

•	 Configure the TLSI 201, using the Room Agent software.

Rear Panel Connectors and Features
For complete information about the rear panel connectors and features, see the TLSI 201 
User Guide.

AAA BBB CCC DDD

DEVICE LAN/PoE+OUTPUTINPUT

Figure 205.	  TLSI 201 Rear Panel

A	 HDMI input

B	 HDMI output

C	 DEVICE port

D	 LAN/PoE+ port

ATTENTION:

•	 The TLSI 201 is Power over Ethernet (PoE 803.3at, class 4) compliant. Do not 
connect the power supply before reading the "Attention" in the "Rear Panel 
Features" section of the TLSI 201 User Guide.

•	 Le TLSI 201 support l’alimentation via Ethernet (PoE 803.3at, classe 4). Veuillez 
lire la partie « Attention » dans la section « Rear Panel Features » du TLSI 201 
User Guide, avant de mettre sous tension les écrans tactiles.

A	 HDMI input — At present, this port is not used by the TLSI 201. 

figure 206
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B	 HDMI output (see figure 206 on page 143) — Connect this HDMI type A port to a 
third-party display. The TLSI 201 supports output resolutions up to 4K. 

Use the provided LockIt HDMI lacing bracket to secure the HDMI connector:

1.	 Plug the HDMI cable into the TLSI 201 HDMI output port (see figure 207, 1).

2.	 Loosen the HDMI connection mounting screw from the panel enough to allow the 
LockIt lacing bracket to be placed over it (2). The screw does not have to be 
removed.

3.	 Place the LockIt lacing bracket on the screw and against the HDMI connector (3), 
then tighten the screw to secure the bracket.

ATTENTION:

•	 Do not overtighten the HDMI connection mounting screw. The shield it 
fastens to is very thin and can easily be stripped.

•	 Ne serrez pas trop la vis de montage du connecteur HDMI. Le blindage 
auquel elle est attachée est très fin et peut facilement être dénudé.

4.	 Loosely place the included tie wrap around the HDMI connector and the LockIt 
lacing bracket as shown (4).

5.	 While holding the connector securely against the lacing bracket, tighten the tie 
wrap, then remove any excess length (5).

3

111
222

333

444

555

Figure 206.	  Securing the HDMI Connector

C	 DEVICE port — supports High-speed USB 2.0 control. Plug a Type-A USB cable from 
the third-party touchpanel into this port.	

NOTE:	 If using a non-touch display, connect a USB mouse to the USB port on the 
TLSI 201 to click screen icons.

D	 LAN/PoE+ port — Use an Ethernet cable to connect this port to the network via a 
PoE+ power sourcing equipment (PSE, not provided). This can be a power injector (see 
figure 207 on page 145) or PoE+ switch.

NOTE:	 The TLSI 201 does not include any PoE+ power sourcing equipment. This 
must be purchased separately.

HDMI output

DEVICE port

LAN/PoE+ port
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Extron recommends the Extron PI 140 power injector (see figure 208). Your power 
injector may look different.

1.	 Use an Ethernet cable to connect the LAN/PoE+ port of the TLSI 201 to the power 
output of the 803.3at, class 4 compliant PoE+ power injector.

2.	 Connect the network input of the power injector to a network switch or router.

Alternatively, use an Ethernet cable to connect the LAN/PoE+ port of the TLSI 201 
to a PoE+ switch.

LAN + PWR OUT

PI 115

LAN

100/240V ~ ,50-60Hz
0.45A MAX

PWR

To network switch To interface

Figure 207.	 PI 115 Power Injector

Front Panel Features

AAA BBB CCC DDD

SIGNAL
INPUT OUTPUT

HDCP

R MENU

TLSI 201

Figure 208.	  TLSI 201 Front Panel

A	 Power LED — Indicates the power status and the reset status of the unit. 

B	 Reset button (recessed) — Allows the unit to be reset in any of three different modes. 
It also allows the user to toggle between enabling and disabling the DHCP client. A brief 
summary of the reset modes is given below. For more information see the TLSI 201 
User Guide.

C	 MENU button (recessed) — Opens the Setup Menu (see page 147) and Calibration 
screen for the TLSI 201:

Setup Menu

1.	 Press the button briefly (less than 3 seconds) to open the internal menu screens.

2.	 Press the button briefly for a second time to exit the setup menu.

Calibration Screen

1.	 Press and hold the button (3 seconds or more) to open the Calibration screen. 
Follow the on-screen instructions to calibrate the touchpanel.

2.	 Complete the calibration process or press the button briefly (less than 2 seconds) 
for a second time to exit the Calibration screen.

D	 Status LEDs — The Signal LEDs light green when a video signal is detected and are 
unlit when no signal is detected.

The HDCP LEDs light green when HDCP content is detected and are unlit when HDCP 
content is not detected.

figure 207

figure 208
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Reset Modes
The TLSI 201 offers the following reset modes:

•	 Use Factory Firmware — Press and hold the Reset button (see figure 208, B, on 
page 145) while applying power to the unit. Use this mode to replace firmware in the 
event of firmware failure.

•	 Reset All IP Settings — Press and hold the Reset button for 6 seconds. After the 
Power LED (A) flashes twice, release and momentarily press the Reset button. Use 
this mode to reset all network settings without affecting user-loaded files.

•	 Reset to Factory Defaults — Press and hold the Reset button for 9 seconds. After 
the Power LED flashes three times, release and momentarily press the Reset button. 
Use this mode to return the device to factory default settings. 

NOTES:

•	 The factory configured passwords for all accounts on this device have 
been set to the device serial number. Passwords can be changed during 
configuration. They are case sensitive.

•	 If the device is reset to default settings, the passwords are reset to the default 
password, which is extron (for either admin or user).

•	 Enable or Disable the DHCP Client — This mode toggles between DHCP enabled 
and DHCP disabled. Press the Reset button five times, consecutively. After the fifth 
press, do not press the button again within 3 seconds. If DHCP was enabled, it is now 
disabled and the Power LED blinks three times. If DHCP was disabled, it is now enabled 
and the Power LED blinks six times.
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Setup Menu
Press the MENU button (see figure 208, C, on page 145) to open the setup menu (see 
figure 212). There are five available screens that are selected by pressing the appropriate 
button in the navigation bar on the left side of the screen.

•	 The STATUS screen is read-only and provides a summary of the other screens.

•	 The NETWORK screen is used to edit the network settings (DHCP setting, IP, subnet 
mask, gateway, and DNS Primary addresses).

•	 The OUTPUT screen is used to configure the image shown by the third-party display, 
using built-in test patterns and EDID.

•	 The AUDIO screen is used to set audio levels.

•	 The ADVANCED screen provides information about the system and the memory. It also 
allows you to add or reset a PIN.

Press the EXIT button to close the setup menu.

For more information about the setup menu, see the TLSI 201 User Guide at 
www.extron.com.

Touchpanel Setup EXIT

STATUS

NETWORK

OUTPUT

AUDIO

ADVANCED

Status

Audio
Click Volume

Click Mute

75

Off

Device Information

Model

Part Number

Firmware

Bootloader

TLSI 201

60-1669-101

1.00.0001-b005

1.00.0000

Output

Resolution 1920x1080

Network

IP Address

Hostname

DHCP Off

192.168.254.251

TLSI-201-1A-FF-E4

Figure 209.	   Setup Menu 

https://www.extron.com
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TLSI 201 Web Page
1.	 To access the TLSI 201 default web page, enter the IP address of the unit into the web 

browser of a PC connected to the same subnet.

A dialog opens asking for the device username and password.

NOTES:

•	 The factory configured passwords for all accounts on this device have 
been set to the device serial number. Passwords can be changed during 
configuration. They are case sensitive.

•	 If the device is reset to default settings, the passwords are reset to the default 
password, which is extron (for either admin or user).

The single page (see figure 211) provides general and network information about the 
unit.

Figure 210.	 TLSI 201 Web Page

2.	 Click the various EDIT buttons to change the associated TLSI 201 settings.

3.	 Use the Network Settings EDIT button to configure the TLSI 201 network settings.

You can also configure the network settings of the TLSI 201 by using the Setup Menu 
(see page 147) or Toolbelt (see the Toolbelt Help File).

To update the device firmware:

1.	 If necessary, download the firmware file to the control PC.

2.	 On the TLSI web page, click Select File and navigate to a firmware file saved on the 
PC.

3.	 Click Update.

The new firmware is installed on the TLSI 201.
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Reference 
Information

This section provides a central location for additional Room Scheduling System information, 
including:

•	 Network Port Requirements and Licensed Third-Party Software

•	 Supported Languages

•	 Secure Sockets Layer (SSL) Certificates

•	 IEEE 802.1X Certificates

•	 SNMP

Network Port Requirements and Licensed Third-Party Software
For information about network port requirements and licensed third-party software for the 
touchpanels described in this guide, please refer to the Extron TouchLink Scheduling Panels 
Network Ports and Licenses Guide, which is available at www.extron.com.

Supported Languages
Room Agent software supports scheduling panel displays in the following languages:

•	 English •	 Arabic •	 Catalan •	 Chinese (simplified)

•	 Chinese (traditional) •	 Croatian •	 Czech •	 Danish

•	 Dutch •	 Finnish •	 French •	 German

•	 Hebrew •	 Italian •	 Japanese •	 Korean

•	 Norwegian •	 Polish •	 Portuguese •	 Russian

•	 Serbian •	 Slovenian •	 Spanish •	 Swedish

•	 Thai •	 Turkish •	 Vietnamese

https://www.extron.com
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Room Scheduling Analytics
Room scheduling touchpanels provide the information needed to analyze room usage, 
activity patterns, and occupancy trends across the organization. A Scheduling Activity 
file with room usage and meeting data can be downloaded concurrently from multiple 
touchpanels. You can transform this readily-available information with data analytics tools to 
create powerful reports.

Extron provides a Microsoft Power BI Usage Template that can be used to visualize activity 
data.

Downloading the Microsoft Power BI Template
1.	 Download the template from the Room Agent page on the Extron website.

2.	 Unzip the Extron Conference Room Scheduling Usage Template.zip. file. This contains 
the Power BI template.

Exporting the Activity File as the Data Source from Room Agent
1.	 To export your data from your panels, navigate to Panel Configuration (1)

2.	 Select the Status checkboxes for all the panels for which you wish Room Agent to 
download the activity file (2).

3.	 Click Retrieve Activity File (3).

Figure 211.	 Retrieve Activity File

4.	 You are prompted to save the file. Make a note of where the file is saved so that it can 
be retrieved later.

step 4

https://www.extron.com
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Importing an Activity File as the Data Source
1.	 Double click Extron Conference Room Scheduling Usage Template.pbit.

2.	 Power BI launches with a prompt regarding a missing data. Close this dialog to see the 
skeleton view of the visual shown earlier.

Figure 212.	 Power BI Selecting Edit Queries

3.	 From the Edit Queries drop-down list (1), select Edit Queries (2).

4.	 The Edit Queries page opens.

Figure 213.	 Power BI Edit Queries

5.	 In the Applied Steps section (1) of the Query Settings panel, click the Gear icon 
next to Source (2).

6.	 Browse to the Room Activity file saved in step 4 of the previous section and open it.

Figure 214.	 Select Table

7.	 Click Table (1).
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8.	 The Navigation Step dialog box opens:

Figure 215.	 Navigation Step Dialog

9.	 Click Continue (1).

10.	Your data is displayed in the Power BI Editor.

Figure 216.	 Data Displayed in Power BI Editor

11.	Click Close & Apply (1). The dashboard displays your data.

Figure 217.	 Power BI Dashboard with Data

Retrieving an Activity File via SFTP
This feature allows the user to obtain the raw activity log data over the network without 
using Room Agent software.

1.	 Connect to the TLS using an SFTP Client.

2.	 Enter the admin credentials on port 22022. By default, the user name is admin and the 
password is extron.

3.	 Navigate to the admin directory (/var/uf/admin) and locate the activity file 
(activity.csv). This contains all the activity information (including headers) in CSV 
format.
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Secure Sockets Layer (SSL) Certificates
Extron TouchLink Pro control system products ship with factory-installed SSL certificates 
created by Extron. The factory default SSL Certificate is a self-signed SSL Certificate, seen 
on products in the factory default state.  If you want or are required to use a different SSL 
certificate at your installation site, please contact your IT department to obtain a valid signed 
SSL Certificate. You can use system utilities in the Extron Toolbelt software to upload your 
new SSL certificate to the TouchLink Pro panel. The Toolbelt Help File provides instructions 
on how to apply an SSL certificate to a control system product.

NOTES:

•	 You must run Toolbelt as an administrator.

•	 Some certificates require a passphrase that is created when the certificate is 
created. If a passphrase is required, you must enter that passphrase before 
uploading and applying the certificate.

These devices support standard OpenSSL certificate encodings such as .pem (Privacy-
enhanced Electronic Mail) and .der (Distinguished Encoding Rules) file types. PEM file types 
are ASCII encoded and are the required format for uploading to the Extron control product. 
DER file types are binary encoded and can typically have several file extension variations, 
such as .crt and .cer. There are many standard tools that can convert from DER to PEM 
file encodings if needed.

NOTE:	 A DER format file must be converted to PEM encoding before uploading it to 
the button panel, control processor, or collaboration receiver.

To properly create the certificate for uploading to Extron control devices, ensure that the 
certificate file meets the following requirements:

•	 contains X.509 certificate information

•	 contains public and private keys

•	 uses PEM encoding

NOTE:	 ITU-T standard X.509 covers aspects of public key encryption, digital 
cryptography, certificates, and validation.

Contact your IT administrator for more information on what tools and policies are required to 
obtain or create the SSL certificate and, if necessary, the corresponding passphrase.
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IEEE 802.1X Certificates
IEEE 802.1X is a standard that enables port-based network access control via an 
authentication server. The protocol requires that all devices must be authenticated before 
gaining privileges to access the secure part of the network.

The Extron implementation of 802.1X supports PEAP - MSCHAPV2 and EAP - TLS 
methods of authentication. This section of the guide details the Certificate File 
Requirements and the Private Key File Requirements (see the next page) to be used in 
the system.

Extron provides resources for learning about 802.1X implementation:

•	 The Extron 802.1X Technology Reference Guide, available from www.extron.com, is 
the primary resource for background information, system planning, topology, and how 
to set up these systems.

•	 The Toolbelt Help file provides detailed step-by-step information on using the software 
to set up 802.1X for TouchLink scheduling (TLS) panels and on troubleshooting.

•	 The 802.1X Primer white paper, also available from www.extron.com, provides a 
general overview of the protocol and its use within a control system.

NOTES:

•	 You must run Toolbelt as an administrator.

•	 Machine certificates require a private key file, which can be encrypted.

Certificate File Requirements
PEM (Privacy-enhanced Electronic Mail) file types are ASCII encoded, and they are the 
required format for 802.1X authentication for TLS panels. DER (Distinguished Encoding 
Rules) file types are binary encoded and can typically have several file extension variations, 
such as .crt and .cer.

NOTE:	 DER encoded files (files with .der, .crt, or .cer extensions that are encoded 
in DER binary format) must be converted to a PEM encoded file type (.pem) before 
being used for authentication.

DER encoded certificates must be converted to PEM encoding using a third-party tool. 
Contact your IT administrator for more information on required tools.

To create the 802.1X security certificate for uploading to Extron TLS panels, ensure that the 
certificate file meets the following requirements:

•	 It contains X.509 certificate information.

•	 It contains a private key (for machine certificates only).

•	 It is PEM encoded.

•	 It has a file extension that is .crt or .pem

•	 Its file name consists of the following types of valid characters:

•	 Alphanumerical (A-Z, a-z, 0-9) characters

•	 Some special characters (colon [:], underscore [_], and hyphen [-])

NOTE:	 Spaces are not permitted anywhere in the name.

https://www.extron.com
https://www.extron.com
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Private Key File Requirements
Private key files are required only when employing machine certificates. Follow these 
requirements for creating a private key:

•	 Its file name consists of the following types of valid characters:

•	 Alphanumerical (A-Z, a-z, 0-9) characters

•	 Some special characters (colon [:], underscore [_], and hyphen [-])

•	 It has a file extension that is .key or .pem.

•	 It can have optional encryption (via password or passphrase).

SNMP
Extron control products support Simple Network Management Protocol (SNMP). SNMP 
facilitates the exchange of basic network management information between network 
devices. It helps in the monitoring of operations and factors such as packet usage, 
memory usage, remote password resets, and collection of error information. An information 
technology administrator can use common IT tools to monitor those factors, as well as look 
up device location and the name of the contact person for the device.

The SNMP controls within Toolbelt provide a way to enable or disable SNMP. They also 
allow you to specify related information such as the name of a contact person, the physical 
location of the unit, and a community name. The text that is specified in these fields is seen 
by the network community when the unit is queried.

Extron control products support the following security levels:

•	 Management Information Base 2 (MIB-II)

•	 SNMPv2c.

NOTE:	 By default, SNMP is disabled for the TLSI 201. Select the Enable SNMP 
checkbox in the Toolbelt Utilities tab (see figure 219, 1) to enable it.

Figure 218.	  Enable SNMP



 

Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date 
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall 
deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty 
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia:
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan:
Extron Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Africa and Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process.

	 USA:	 714.491.1500 or 800.633.9876	 Asia:	 65.6383.4400 

	 Europe:	 31.33.453.4040 or 800.3987.6673	 Japan:	 81.3.3511.7655
	 Africa and Middle East:	 971.4.299.1800 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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